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Disclaimer of Warranties and Limitation of Liability

The information, recommendations, descriptions and safety notations in this document are based on 
Eaton Corporation’s (“Eaton”) experience and judgment and may not cover all contingencies. If further 
information is required, an Eaton sales office should be consulted. Sale of the product shown in this 
literature is subject to the terms and conditions outlined in appropriate Eaton selling policies or other 
contractual agreement between Eaton and the purchaser. THERE ARE NO UNDERSTANDINGS,
AGREEMENTS, WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF FITNESS FOR A 
PARTICULAR PURPOSE OR MERCHANTABILITY, OTHER THAN THOSE SPECIFICALLY SET OUT IN ANY 
EXISTING CONTRACT BETWEEN THE PARTIES. ANY SUCH CONTRACT STATES THE ENTIRE OBLIGA-
TION OF EATON. THE CONTENTS OF THIS DOCUMENT SHALL NOT BECOME PART OF OR MODIFY 
ANY CONTRACT BETWEEN THE PARTIES. 

In no event will Eaton be responsible to the purchaser or user in contract, in tort (including negligence), 
strict liability or otherwise for any special, indirect, incidental or consequential damage or loss
whatsoever, including but not limited to damage or loss of use of equipment, plant or power system, 
cost of capital, loss of power,additional expenses in the use of existing power facilities, or claims
against the purchaser or user by its customers resulting from the use of the information, recommenda-
tions and descriptions contained herein.
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Support Services

Support Services

The goal of Eaton is to ensure your greatest possible satisfaction
with the operation of our products. We are dedicated to
providing fast, friendly and accurate assistance. That is why we
offer you so many ways to get the support you need. Whether
it’s by phone, fax or e-mail, you can access Eaton’s support
information 24 hours a day, seven days a week. Our wide range
of services is listed below.
You should contact your local distributor for product pricing,
availability, ordering, expediting and repairs.

Website

Use the Eaton website to find product information. You can also
find information on local distributors or Eaton’s sales offices.
Website Address
www.eaton.com/electrical

EatonCare Customer Support Center

Call the EatonCare Support Center if you need assistance with
placing an order, stock availability or proof of shipment,
expediting an existing order, emergency shipments, product
price information, returns other than warranty returns, and
information on local distributors or sales offices.
Voice: 877-ETN CARE (386-2273) (8:00 am – 6:00 pm EST)
FAX: 800-752-8602
After-Hours Emergency: 800-543-7038
(6:00 pm – 8:00 am EST)

If you are in the US or Canada, and have OI or PLC questions,
you can take advantage of our toll-free line for technical
assistance with hardware and software product selection,
system design and installation, and system debugging and
diagnostics. Technical support engineers are available for calls
during regular buiness hours.
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Technical Resource Center

Voice: 877-ETN CARE (386-2273) (8:00 am – 5:00 pm EST)
FAX: (828) 651-0549
e-mail: TRC@Eaton.com

European PanelMate Support Center

This engineering company, located in Zurich, Switzerland,
provides high-level quality support and repair assistance for your
PanelMate products. You will receive technical and application
support.

For Customers in Europe, contact:
BFA Solutions, Ltd.
Voice: +41 1 806 64 44 (9:00 am – 5:00 pm CET)
e-mail: gk@bfa.ch
www.bfa.ch

Repair and Upgrade Service

Additional support is also available from our well-equipped
Repair and Upgrade Service department. If you have questions
regarding the repair or upgrade of OI product, contact your local
distributor.

Repair and Upgrade Service (support for OI)

Voice:
877-ETN-CARE (877-386-2273) (8:00 am – 5:00 pm EST)
414-449-7100 (8:00 am – 5:00 pm EST)
FAX: 614-882-3414
e-mail: TRC@eaton.com
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IQ 100 Series Meter Overview and Specifications

Hardware Overview

The IQ 100 (IQ 130/140/150) is a multifunction power meter designed to be used in electrical substa-
tions, panel boards and as a power meter for OEM equipment.  The unit provides multifunction measure-
ment of most electrical parameters.  

The unit is designed with advanced meaurement 	capabilities, allowing it to achieve high performance 
accuracy.  The IQ 100 meter is specified as a 0.5% class energy meter for billing applications as well as 
a highly accurate panel indication meter. 

The IQ 100 meter provides a host of additional capabilities, including optional RS485 with Modbus RTU 
and RJ45 Ethernet connection with Modbus TCP communication.

IQ 100 meter features that are detailed in this manual are as follows:
0.5% Class Revenue Certifiable Energy and Demand (IQ 140/150) Metering•	
Meets ANSI C12.20 (0.5%) •	
Multifunction Measurement including Voltage, Current, Power, Frequency, Energy, etc.•	
Field Upgrade without Removing Installed Meter•	
Percentage of Load Bar for Analog Meter Perception•	
Easy to Use Faceplate Programming•	
RS485 or RJ45 Modbus Communication•	

The IQ 100 Series meter is available in two configurations: meter with integral display and transducer 
only. 

IQ 100 Series Meter with Integral Display
Meter with integral display in one compact unit.  Features an optional RS485 (Modbus RTU) and KYZ 
Pulse Output or optional RJ45 (Modbus TCP) Ethernet port and KYZ Pulse Output, and can be pro-
grammed using the faceplate of the meter.  ANSI or DIN mounting may be used.

IQ 100 Series Digital Transducer (No display)
A Digital Transducer only unit providing KYZ Pulse Output and RS485 communication via Modbus RTU 
or Modbus ASCII protocols or optional RJ45 (Modbus TCP) Ethernet port and KYZ Pulse Output.  The 
unit is designed to install using DIN Rail Mounting (see instructions on page 22).

Voltage and Current Inputs

Universal Voltage Inputs
Voltage Inputs allow measurement to 416 Volts Line-to-Neutral and 721 Volts Line-to-Line.  This insures 
proper meter safety when wiring directly to high voltage systems.  One unit will perform to specification 
on 69 Volt, 120 Volt, 230 Volt, 277 Volt, 277 Volt and 347 Volt power systems. 
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Current Inputs

The IQ 100 Series meter’s Current Inputs use a unique dual input method:

Method 1:  CT Pass Through •	
	 The CT passes directly through the meter without any physical termination on the meter.  This 		
	 insures that the meter cannot be a point of failure on the CT circuit.  This is preferable for utility 		
	 users when sharing relay class CTs.  No Burden is added to the secondary CT circuit.

Method 2:  Current Gills•	
	 This unit additionally provides ultra-rugged Termination Pass Through Bars that allow CT leads to 
	 be terminated on the meter.  This, too, eliminates any possible point of failure at the meter.  This 		
	 is a preferred technique for insuring that relay class CT integrity is not compromised (the CT will 		
	 not open in a fault condition).  

Ordering Information

    IQ -    150  - M - A - 6 - 5 - 1 - 1 
                          1         2             3     4    5     6    
     1. Model:
          130 = Volts/Amps Meter
          140 = Power Meter
          150 = Energy Meter
     2. Meter Type
         M = Meter (with integral display)
         T = Transducer Only (no display, with either RS485 or RJ45 option)
     3. Frequency:
          5 = 50 Hz System
          6 = 60 Hz System
     4. Current Input:
          5 = 5 Amp Secondary
          1 = 1 Amp Secondary
     5. Power Supply:
          1 = Universal, (90 - 265) VAC @50/60Hz or (100-370) VDC 						   
          4 = (18 - 60) VDC	
     6. Communication
          0 = None (see Programmable Settings and Factory Settings sections beginning on the next page) 
          1 = RS485 with Modbus RTU and KYZ Pulse Output          
          2 = RJ45 Ethernet connection with Modbus TCP and KYZ Pulse Output

     Example: IQ 150-M-A-6-5-1-1

     (IQ 150 Energy Meter with 60 Hz System, 5 Amp Secondary, 90-265 VAC/100-370 VDC Power Supply, RS485 
      Modbus and KYZ Pulse Output)
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Measured Values	

	 The following table lists the measured values available for the different IQ 100 Series models.

IQ 100 Series Feature Comparison
Readings/Features  IQ 130 IQ 140 IQ150
Volts L-N Yes Yes Yes
Volts L-N Max/Min Yes Yes Yes
Volts L-L Yes Yes Yes
Volts L-L Max/Min Yes Yes Yes
Amps Yes Yes Yes
Amps Neutral Yes Yes Yes
Amps Max/Min Yes Yes Yes
kW, +/-/, Max/Min No Yes Yes
kVAR, +/-/, Max/Min No Yes Yes
PF, +/-/, Max/Min No Yes Yes
kVA, Max,/Min No Yes Yes
Frequency No Yes Yes
kWh No No Yes
kVARh No No Yes
kVAh No No Yes
Energy Accumulators No No Yes
Demand Values No Yes Yes

Programmable Values	

	 An IQ 100 Series meter that does not have either the RS485 or RJ45 communication options can
	 only be programmed through the front panel. Not all meter settings are available through the front 
	 panel. 	The following table lists the programmable settings for meters with and without RS485 or
	 RJ45 communication options.		

COM
Option

Scroll CT 
Setting

PT 
Setting

Connection 
Type

Password
Enable

Communication Reset Scaling 
-Energy 

and Power
With RS485/

RJ45
Yes Yes Yes Yes Yes Yes Yes Yes

Without 
RS485/RJ45

Yes Yes Yes Yes No No   Yes* No

	 * NOTES:
	     - Reset Energy is not available in a meter without RS485 or RJ45 communication option.
	     - Because a meter without RS485 or RJ45 communication option does not support password 
	       enabling, the Reset Max/Min/All commands are not password protected.
	

                  The next section lists the factory settings for the IQ 100 Meter. Without either the RS485 or 
	 RJ45 communication option, you won’t be able to change some of these settings.
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Factory Settings	

	 The following table lists the default settings for the IQ 100 Series meter. The settings which 
	 cannot be changed via the front panel are noted; if the meter does not have the RS485 or RJ45 
	 option, these settings cannot be changed at all.
 

Setting Default Value Configurable through 
Front Panel?

Power Scale Auto No

Energy Digits 8 No
Energy Decimal Places 0 No

Energy Scale kilo (k) No
Power Direction View as Load No

Demand Averaging Method Fixed No
Demand Averaging Interval 15 (minutes) No

Demand Averaging Sub-interval None No
Auto-Scrolling Display Yes Yes

Display Configuration Volts L-L, Volts L-N, Amps, W/VAR/PF, VA/Hz, Wh, 
VARh, VAh

No

CT Numerator 1 (for 1Amp model) or 5 (for 5 Amp model) Yes
CT Denominator 1 (for 1Amp model) or 5 (for 5 Amp model) Not changeable through 

software or front panel
CT Multiplier 1 No

PT Numerator 120 Yes
PT Denominator 120 Yes

PT Multipler 1 Yes
System Wiring 3 Element Wye Yes

Phases Displayed ABC No
RS485 COM Address 1 Yes*
RS485 COM Protocol Modbus RTU Yes*

RS485 COM Baud Rate 9600 Yes*

RS485 COM Response Delay 0 No*
IP Address 10.0.0.1 No**

Subnet Mask 255.255.255.0 No**
Ethernet Option Baud Rate 57600 No**
Ethernet Option Protocol Modbus TCP No**

Password Disabled No
	 * If the meter does not have the RS485 option, these settings do not apply.
	 ** If the meter does not have the RJ45 Ethernet option, these settings do not apply.

Utility Peak Demand (IQ140/150)

The IQ 100 Series meter provides user-configured Fixed Window or Sliding Window Demand.  This 
feature allows you to set up a Customized Demand Profile.  Fixed Window Demand is demand used over 
a user-configured demand period (usually 5, 15 or 30 minutes).  Sliding Window Demand is a fixed 
window demand that moves for a user-specified subinterval period.  An example of Sliding Window  
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Demand is a 15-minute demand using 3 subintervals and providing a new demand reading every 5 min-
utes, based on the last 15 minutes.
Utility Demand Features can be used to calculate kW, kVAR, kVA and PF readings.  All other parameters 
offer Max and Min capability over the user-selectable averaging period.  Voltage provides an Instanta-
neous Max and Min reading which displays the highest surge and lowest sag seen by the meter.

Specifications
	 Power Supply

	 ·	 Range:				   1 Option: Universal, (90 to 265) VAC @50/60Hz or (100 to 
							          370) VDC
						      4 Option: (18-60) VDC
	 ·	 Power Consumption:		 5 VA, 3.5W

	 Voltage Inputs (Measurement Category III)

	 ·	 Range:				   Universal, Auto-ranging up to 416VAC L-N, 721VAC L-L
	 ·	 Supported hookups:		  3 Element Wye, 2.5 Element Wye, 2 Element Delta, 4 Wire 
						         Delta 
	 ·	 Input Impedance:		  1M Ohm/Phase
	 ·	 Burden: 			   0.0144VA/Phase at 120 Volts
	 ·	 Pickup Voltage:		  10Vac
	 ·	 Connection:			   Screw terminal (Figure 3.4)
	 ·	 Max Input Wire Gauge:	 AWG#12 / 2.5mm2

	 ·	 Fault Withstand:		  Meets IEEE C37.90.1
	 ·	 Reading:			   Programmable Full Scale to any PT Ratio 

	 Current Inputs

	 ·	 Class 10: 			   5A Nominal, 10A Maximum
	 ·	 Class 2:			   1A Nominal, 2A Maximum 
	 ·	 Burden:			   0.005VA Per Phase Max at 11 Amps
	 ·	 Pickup Current:		  0.1% of Nominal

	 ·	 Connections: 			  O or U Lug Electrical Connection
						      Pass-through Wire, 0.177” / 4.5mm Maximum Diameter 
						      Quick Connect, 0.25” Male Tab 

	 ·	 Fault Withstand (at 23oC): 	 100A/10sec., 300A/3sec., 500A/1sec.
	 ·	 Reading:			   Programmable Full Scale to any CT Ratio

	 Isolation

	 ·	 All Inputs and Outputs are galvanically isolated to 2500 VAC

	 Environmental Rating

	 ·	 Storage:			   (-20 to +70)0 C
	 ·	 Operating:			   (-20 to +70)0 C
	 ·	 Humidity:			   to 95% RH Non-condensing
	 ·	 Faceplate Rating:		  NEMA12 (Water Resistant), Mounting Gasket Included 
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	 Measurement Methods

	 ·	 Voltage, Current:		  True RMS
	 ·	 Power:				   Sampling at 400+ Samples per Cycle on All Channels 
						         Measured Readings Simultaneously
	 ·	 A/D Conversion:		  6 Simultaneous 24 bit Analog to Digital Converters

	 Update Rate

	 ·	 Watts, VAR and VA:		 100 milliseconds (Ten times per second)
	 ·	 All other parameters:		 1 second

	 Communication Format

		  1. Optional RS485 and KYZ Pulse Output through backplate 
		  2. Optional RJ45 Ethernet connection and KYZ Pulse Output through backplate
	
	 ·	 Protocols: 			   Modbus RTU, Modbus ASCII, Modbus TCP 
	 ·	 Com Port Baud Rate:		 9600 to 57600 b/s
	 ·	 Com Port Address: 		  001-247
	 ·	 Data Format:			   8 Bit, No Parity
	 ·	 IQ 100 Series Transducer
		   with RS485			   Default Initial Communication Baud 9600 (see page 46)

	 Mechanical Parameters

	 ·	 Dimensions:			   (H4.85 x W4.85 x D4.65) inches, (H123.2 x W123.2 x 
						         D118.1) mm
						      Mounts in 92mm square DIN or ANSI C39.1, 4” Round Cut-out
	 ·	 Weight:			   2 pounds, 0.907kg (ships in a 6”/152.4mm cube container)

KYZ/RS485 Port Specifications 

	 RS485 Transceiver; meets or exceeds EIA/TIA-485 Standard

	 Type:				    Two-wire, half duplex
	 Min. Input Impedance:		  96kΩ
	 Max. Output Current:		  ±60mA

Wh Pulse 

	 KYZ output contacts (and infrared LED light pulses through face plate):
	   (See page 56 for Kh values.)

	 Pulse Width:			   40ms
	 Full Scale Frequency:		  ~6Hz
	 Contact type:			   Solid State – SPDT (NO – C – NC)
	 Relay type:			   Solid state
	 Peak switching voltage:	 DC ±350V
	 Continuous load current:	 120mA
	 Peak load current:		  350mA for 10ms
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Compliance

UL Listing: USL/CNL E185559•	
IEC 687 (0.5% Accuracy)•	
ANSI C12.20 (0.5% Accuracy)•	
ANSI (IEEE) C37.90.1 Surge Withstand•	
ANSI C62.41 (Burst)•	
CE Compliant•	
IEC1000-4-2:  ESD•	
IEC1000-4-3:  Radiated Immunity•	
IEC1000-4-4:  Fast Transient•	
IEC1000-4-5:  Surge Immunity•	
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Accuracy

	 For 230 C, 3 Phase balanced Wye or Delta load, at 50 or 60 Hz (as per order), 5A (Class 10) 
	 nominal unit.	
	

Parameters Accuracy Accuracy Input Range
Voltage L-N [V] 0.25% of reading2 (69 to 480)V
Voltage L-L [V] 0.25% of reading (120 to 600)V
Current Phase [A] 0.25% of reading1 (0.15 to 5)A
Current Neutral (Calculated) [A] 2.0% of reading1 (0.15 to 5)A @ (45 to 65)Hz
Active Power Total [W] 0.5% of reading1,2 (0.15 to 5)A@(69 to 480)V@+/- (0.5 to 1)lag/lead PF 
Active Energy Total [Wh] 0.5% of reading1,2 (0.15 to 5)A@(69 to 480)V@+/- (0.5 to 1)lag/lead PF 
Reactive Power Total [VAR] 0.5% of reading1,2 (0.15 to 5)A@(69 to 480)V@+/- (0 to 0.8)lag/lead PF 
Reactive Energy Total [VARh] 0.5% of reading1,2 (0.15 to 5)A@(69 to 480)V@+/- (0 to 0.8)lag/lead PF 
Apparent Power Total [VA] 0.5% of reading1,2 (0.15 to 5)A@(69 to 480)V@+/- (0.5 to 1)lag/lead PF 

Apparent Energy Total [VAh] 0.5% of reading1,2 (0.15 to 5)A@(69 to 480)V@+/- (0.5 to 1)lag/lead PF 
Power Factor 0.5% of reading1,2 (0.15 to 5)A@(69 to 480)V@+/- (0.5 to 1)lag/lead PF 
Frequency +/- 0.01 Hz (45 to 65) Hz
% of Load Bar +/- 1 segment (0.005 to 6)A

1 For 2.5 element programmed units, degrade accuracy by an additional 0.5% of reading.  
	 - For 1A (Class 2) Nominal, degrade accuracy by an additional 0.5% of reading.  
	 - For 1A (Class 2) Nominal, the input current range for Accuracy specification is 20% of 	
	    the values listed in the table. 
2 For unbalanced voltage inputs where at least one crosses the 150V auto-scale threshold (for   
     example, 120V/120V/208V system), degrade accuracy by additional 0.4%.
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IQ 100 Series Mechanical Installation

Introduction

The IQ 100 Series meter can be installed using a standard ANSI C39.1 (4” Round) or an IEC 92mm DIN 
(Square) form.  In new installations, simply use existing DIN or ANSI punches.  For existing panels, pull 
out old analog meters and replace with the IQ 100 Series meter.  The various models use the same 
installation.  See the next chapter for wiring diagrams.

        Meter Face                                   Meter Dimensions                      Transducer Dimensions

         Meter Back                         ANSI Mounting Panel Cut-out                 DIN Mounting Cut-out

Recommended Tools for IQ 100 Series meter Installation:  #2 Phillips screwdriver, small wrench and •	
wire cutters.  Transducer Installation doesn’t require any tools.
Mount the meter in a dry location, which is free from dirt and corrosive substances.  The meter is •	

     designed to withstand harsh environmental conditions (see specifications in the previous chapter).  

DIN 
Mounting 
Brackets

ANSI Mounting 
Rods - screw-in
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ANSI Installation Steps

								      

	 1.	 Insert 4 threaded rods by hand into the back of the meter.  Twist until secure.
	 2.	 Slide ANSI 12 Mounting Gasket onto the back of the meter with rods in place.
	 3.	 Slide the meter with Mounting Gasket into the panel.
	 4.	 Secure from back of panel with lock washer and nut on each threaded rod.
		  Use a small wrench to tighten.  Do not overtighten. The maximum installation torque 
		  is 0.4 Newton-Meter.

NEMA 12 Mounting Gasket

Threaded Rods

Lock Washer and Nut
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DIN Installation Steps

	 1. Slide the meter with NEMA 12 Mounting Gasket into the panel (first remove ANSI studs, if in  
	     place).
	 2. From the back of the panel, slide 2 DIN Mounting Brackets into the grooves in the top and  
	     bottom of the meter housing and snap them into place.
	 3. Secure the meter to the panel with a lock washer and a #8 screw through each of the 2  
	     mounting brackets.  Tighten with a #2 Phillips screwdriver.  Do not overtighten.  

DIN Mounting Bracket

Top Mounting Bracket Groove

Bottom Mounting Bracket Groove

#8 Screw

Remove (unscrew) ANSI studs for 
DIN Installation

Meter with NEMA 12 Mounting Gasket
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IQ 100 Series Transducer Installation

The IQ 100 Series Transducer model is installed using DIN Rail mounting.

Specs for DIN Rail mounting: 	 International Standards DIN 46277-3
DIN Rail (Slotted) dimensions:	 7.55mm x 35mm 

DIN Rail Installation Steps:
      1. Slide top groove of meter onto the DIN Rail.

      2. Press gently until the meter clicks into place.

      NOTE: If mounting with the DIN Rail provided, 
      use the Black Rubber Stoppers (also provided).

To Remove the Meter from the DIN Rail:
      Pull down on the Release clip to detach the unit from  
      the DIN Rail.

NOTE ON DIN RAILS:
DIN Rails are commonly used as a mounting channel for most 
terminal blocks, control devices, circuit protection devices and 
PLCs.  DIN Rails are made of electrolitically plated cold rolled  
steel; they are also available in aluminum, PVC, stainless steel 
and copper.

Release Clip

Black Rubber Stoppers

DIN Rail Detail
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IQ 100 Series Electrical Installation

Considerations When Installing Meters                                                                                                               

Installation of the IQ 100 Series meter must be performed only by qualified personnel who follow •	
standard safety precautions during all procedures.  Those personnel should have appropriate training 
and experience with high voltage devices.  Appropriate safety gloves, safety glasses and protective 
clothing is recommended.

During normal operation of the IQ 100 Series meter, dangerous voltages flow through many parts of •	
the meter, including:  Terminals and any connected CTs (Current Transformers) and PTs (Potential 
Transformers), all I/O Modules (Inputs and Outputs) and their circuits.  All Primary and Secondary 
circuits can, at times, produce lethal voltages and currents.  Avoid contact with any current-carrying 
surfaces.

Do not use the meter for primary protection or in an energy-limiting capacity.  The meter can only be •	
used as secondary protection.  

Do not use the meter for applications where failure of the meter may cause harm or death.  •	

Do not use the meter for any application where there may be a risk of fire.•	

All meter terminals should be inaccessible after installation.•	

Do not apply more than the maximum voltage the meter or any attached device can withstand.  Refer •	
to meter and/or device labels and to the Specifications for all devices before applying voltages.  Do 
not HIPOT/Dielectric test any Outputs, Inputs or Communications terminals.

Eaton recommends the use of Shorting Blocks and Fuses for voltage leads and power supply to 	•	
prevent hazardous voltage conditions or damage to CTs, if the meter needs to be removed from    
service.  CT grounding is optional.

             NOTE: IF THE EQUIPMENT IS USED IN A MANNER NOT SPECIFIED BY THE MANUFACTURER, 
	    THE PROTECTION PROVIDED BY THE EQUIPMENT MAY BE IMPAIRED.

	    
             NOTE: THERE IS NO REQUIRED PREVENTIVE MAINTENANCE OR INSPECTION 
	    NECESSARY FOR SAFETY.  HOWEVER, ANY REPAIR OR MAINTENANCE SHOULD BE 
	    PERFORMED BY THE FACTORY.

DISCONNECT DEVICE:  The following part is considered the equipment disconnect device.
A SWITCH OR CIRCUIT-BREAKER SHALL BE INCLUDED IN THE END-USE EQUIPMENT OR 
BUILDING INSTALLATION.  THE SWITCH SHALL BE IN CLOSE PROXIMITY TO THE
EQUIPMENT AND WITHIN EASY REACH OF THE OPERATOR.  THE SWITCH SHALL BE 

	    MARKED AS THE DISCONNECTING DEVICE FOR THE EQUIPMENT.
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CT Leads Terminated to Meter

The IQ 100 Series meter is designed to have Current inputs wired in one of three ways.  The diagram 
below shows the most typical connection where CT Leads are terminated to the meter at the current 
gills.  This connection uses nickel-plated brass studs (current gills) with screws at each end. This
connection allows the CT wires to be terminated using either an “O” or a “U” lug.  Tighten the screws 
with a #2 Phillips screwdriver. The maximum installation torque is 1 Newton-Meter.

Other current connections are shown in the figures on the next two pages.  Voltage and RS485 connec-
tions are shown on page 27.

                   
                                CT Leads Terminated to Meter, #8 Screw for Lug Connection

Wiring Diagrams are shown beginning on page 28.   
Communications Connections are detailed in the next chapter.

Current gill
(Nickel-plated brass stud)
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CT Leads Pass Through  (No Meter Termination)

The second method allows the CT wires to pass through the CT inputs without terminating at the meter.  
In this case, remove the current gills and place the CT wire directly through the CT opening.  The open-
ing will accomodate up to 0.177” / 4.5mm maximum diameter CT wire.

                                              Pass Through Wire Electrical Connection

Current gills removed

CT wire passing through meter
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Quick Connect Crimp CT Terminations 

For quick termination or for portable applications, a quick connect Crimp CT connection can be used.

                                              Quick Connect Electrical Connection

Crimp CT terminations
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Voltage and Power Supply Connections

Voltage Inputs are connected to the back of the unit via optional wire connectors.  The connectors 
accomodate up to AWG#12 / 2.5mm wire.

                                                            Voltage Connection

Ground Connections

The meter’s Ground Terminals should be connected directly to the installation’s protective earth ground.  
Use 2.5mm wire for this connection.

Voltage Fuses

Eaton recommends the use of fuses on each of the sense voltages and on the control power, even 
though the wiring diagrams in this chapter do not show them.  

Use a 0.1 Amp fuse on each voltage input.•	
Use a 3 Amp fuse on the power supply.•	

Power Supply Inputs

Voltage Inputs

RS485 Output
DO NOT PUT THE VOLTAGE 
ON THESE TERMINALS!

KYZ
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Electrical Connection Diagrams

Choose the diagram that best suits your application.  Be sure to maintain the CT polarity when wiring.
1. 3 Phase, 4 Wire System Wye with Direct Voltage, 3 Element
	     a. Example of Dual Phase Hookup
	     b. Example of Single Phase Hookup
2. 3 Phase, 4 Wire System Wye with Direct Voltage, 2.5 Element   	 3. 3 Phase, 4 Wire Wye with PTs, 3 Element
4. 3 Phase, 4 Wire Wye with PTs, 2.5 Element                             	 5. 3 Phase, 3 Wire Delta with Direct Voltage
6. 3 Phase, 3 Wire Delta with 2 PTs	 	 	 	 	 7. 3 Phase, 3 Wire Delta with 3 PTs
8. Current Only Measurement (Three Phase)	 	 	 	 9. Current Only Measurement (Dual Phase)
10. Current Only Measurement (Single Phase)

1.  Service: WYE, 4 Wire with No PTs, 3 CTs

lc

HI

LO

lb

HI

LO

la

HI

LO

GND
Power
Supply

VRef
A
B
C

L (+)
N (-)

C

C

B

B

A

A

N

N

Select: “3 EL WYE” (3 Element Wye) in Meter 
Programming setup.

C

B

A
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1a.  Example of Dual Phase Hookup
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1b.  Example of Single Phase Hookup
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2.  Service: 2.5 Element WYE, 4-Wire with No PTs, 3 CTs

lc

HI

LO

lb

HI

LO

la

HI

LO

GND
Power
Supply

VRef
A
B
C

L (+)
N (-)

C

C

B

B

A

A

N

N

Select: “2.5 EL WYE” (2.5 Element Wye) in Meter 
Programming setup.

C

B

A
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3.  Service: WYE, 4-Wire with 3 PTs, 3 CTs

C

B

A

Select: “3 EL WYE” (3 Element Wye) in Meter 
Programming setup.

lc

HI

LO

lb

HI

LO

la

HI

LO

GND
Power
Supply

VRef
A
B
C

L (+)
N (-)

C

C

B

B

A

A

N

N
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4.  Service: 2.5 Element WYE, 4-Wire with 2 PTs, 3 CTs

lc

HI

LO

lb

HI

LO

la

HI

LO

GND
Power
Supply

VRef
A
B
C

L (+)
N (-)

C

C

B

B

A

A

N

N

Select: “2.5 EL WYE” (2.5 Element Wye) in Meter 
Programming setup.

C

B

A
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5.  Service: Delta, 3-Wire with No PTs, 2 CTs

C

C

B

B

A

A

lc

HI

LO

lb

HI

LO

la

HI

LO

GND
Power
Supply

VRef
A
B
C

L (+)
N (-)

C

B A

C

B A
Select: “2 Ct dEL” (2 CT Delta) in Meter 
Programming setup.

OR
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6.  Service: Delta, 3-Wire with 2 PTs, 2 CTs 

Select: “2 Ct dEL” (2 CT Delta) in Meter 
Programming setup.

C

C

B

B

A

A

lc

HI

LO

lb

HI

LO

la

HI

LO

GND
Power
Supply

VRef
A
B
C

L (+)
N (-)

C

B A

C

B A

OR
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7.  Service: Delta, 3-Wire with 2 PTs, 3 CTs

Select: “2 Ct dEL” (2 CT Delta) in Meter 
Programming setup.

C

C

B

B

A

A

lc

HI

LO

lb

HI

LO

la

HI

LO

GND
Power
Supply

VRef
A
B
C

L (+)
N (-)

C

B A

C

B A

OR
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8.  Service: Current Only Measurement (Three Phase)

*  Even if the meter is used for only Amp readings, the unit requires a Voltage reference.  
    Please make sure that the voltage input is attached to the meter.
    AC Control Power can be used to provide the Reference Signal.

Select: “3 EL WYE” (3 Element Wye) in Meter 
Programming setup.
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9.  Service: Current Only Measurement (Dual Phase)

Select: “3 EL WYE” (3 Element Wye) in Meter 
Programming setup.

*  Even if the meter is used for only amp readings, the unit requires a Voltage reference.  
    Please make sure that the voltage input is attached to the meter.
    AC Control Power can be used to provide the Reference Signal.

lc

HI

LO

lb

HI

LO

la

HI

LO

GND
Power
Supply

20VAC
Minimum

VRef
A
B
C

L (+)
N (-)

B

B

A

A

N

N
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10.  Service: Current Only Measurement (Single Phase)

Select: “3 EL WYE” (3 Element Wye) in Meter 
Programming setup.

*  Even if the meter is used for only amp readings, the unit requires a Voltage reference.  
    Please make sure that the voltage input is attached to the meter.
    AC Control Power can be used to provide the Reference Signal.

lc

HI

LO

lb

HI

LO

la

HI

LO

GND
Power
Supply

20VAC
Minimum

VRef
A
B
C

L (+)
N (-)

A

A

N

N
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IQ 100 Series Communication Installation

RS485 / KYZ Output  (Communication Port Option)

The IQ 100 Series meter provides an optional combined RS485/KYZ Pulse Output communication port, 
speaking Modbus ASCII or Modbus RTU.

The IQ 100 Series meter’s RS485 connection uses standard 2-wire, Half Duplex architecture.  The •	
RS485/KYZ Pulse Output connector is located on the terminal section of the meter.  A connection 
can easily be made to a Master Device or to other Slave devices.

Care should be taken to connect + to + and - to - connections.•	

See page 56 for the KYZ Output specifications and Pulse constants.•	

RS485 allows you to connect one or multiple IQ 100 Series meters to a PC or other device, at either •	
a local or remote site. All RS485 connections are viable for up to 4000 feet (1219.20 meters). 
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The figure below shows a 2-wire RS485 connection in detail.

For All RS485 Connections:

•  Use a shielded twisted pair cable 22 AWG (0.33 mm2) or thicker, and ground the shield, preferably at 
    one location only.
•  Establish point-to-point configurations for each device on a RS485 bus: connect (+) terminals to (+) 
    terminals; connect (-) terminals to (-) terminals.
•  You may connect up to 31 meters on a single bus using RS485. Before assembling the bus, each 
    meter must have a unique address.
•  Protect cables from sources of electrical noise.
•  Avoid both “Star” and “Tee” connections (see figure on the next page). 
•  No more than two cables should be connected at any one point on an RS485 network, whether the
    connections are for devices, converters, or terminal strips.
•  Include all segments when calculating the total cable length of a network. If you are not using an 
    RS485 repeater, the maximum length for cable connecting all devices is 4000 feet (1219.20 meters).
•  Connect shield to RS485 Master and individual devices as shown in the figure below. You may also 
    connect the shield to earth-ground at one point.
•  Termination Resistors (RT) may be needed on both ends for longer length transmission lines.  How
    ever, since the meter has some level of termination internally, Termination Resistors may not be 
    needed. When they are used, the value of the Termination Resistors is determined by the electrical 
    parameters of the cable.

 The figure below shows a representation of an RS485 Daisy Chain connection. 

Twisted pair, shielded (SH) cable 

RT

+  - SH

RT

+   - SH  +   - SH +   - SH
Slave device 1 Slave device 2 

Last Slave device N Master device 

Earth Connection, preferably at 
single location 

Twisted pair, shielded (SH) cable Twisted pair, shielded (SH) cable 

MAX

MIN

VOLTS L-N

AMPS

%LOAD

120%-

PRG

%THD

LM2

LM1

90%-

60%-

30%-

VOLTS L-N

W/VAR/PF

VA/Hz

Wh

KILO

VARh

VAh

Wh Pulse

MEGA

A

B

C

MENU ENTER

From other RS485 device 
Connect : 

• (−) to (−)
• (+) to (+) 
• Shield(SH) to  Shield(SH)

IQ 100 Series meter RS485 connections 

120.0
120.0
120.0

+

- 

SH
  +

  -

SH
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                                                      Incorrect Topologies

Twisted pair, shielded (SH) cable 

  +  -  SH 

   +  -  SH 

   +  -  SH 

Slave device 1 

Slave device 2 

Last Slave device N Master device 

Earth Connection, preferably at 
single location 

Twisted pair, shielded (SH) cable Twisted pair, shielded (SH) cable 

Twisted pair, shielded (SH) cable 

     + -SH 

Twisted pair, shielded (SH) cable 

Twisted pair, shielded (SH) cable Twisted pair, shielded (SH) cable 

  +  -  SH    +-  SH 

   +  -  SH    +  -SH 

Master device

Slave device 1 Slave device 2 

Slave device 3 Slave device 4 

 

RT RT

   +  -  SH 

Long stub results “T” connection that can cause 
interference problem! 

“STAR” connection can cause interference 
problem! 
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Configuring the Ethernet Connection (RJ45 Port Option)

The RJ45 port option gives the IQ 100/100T Series meter a wired (RJ45) Ethernet connection speaking 
Modbus TCP, allowing it to communicate on a Local Area Network (LAN). The meter is easily config-
ured through a host PC using a Telnet connection. Once configured, you can access the meter directly 
through any computer on your LAN. 
This section outlines the procedures for setting up the parameters for Ethernet communication.
	
Setting up the Host PC to Communicate with the IQ100 Series meter 

•  Consult with your Network Administrator before performing these steps since some of the functions  
    may be restricted to Administrator privileges.
•  The Host PC could have multiple Ethernet Adapters (Network Cards) installed. Identify and configure 
    the one that will be used for accessing the meter.  
•  The PC’s Ethernet Adapter must be set up for point-to-point communication when configuring the  
    RJ45 port option. The Factory default IP parameters programmed into the RJ45 port are:
	 IP Address: 		  10.0.0.1
	 Subnet Mask: 	 255.255.255.0
See following sections for additional parameters.

Configuring the Host PC’s Ethernet Adapter Using Windows XP©

The following example shows the PC configuration settings that let you access the IQ 100 Series meter 
configured with default parameters. Use the same procedure when the settings differ from the default 
settings.  

1. From the Start Menu, select Control Panel>Network  
    Connections. You will see the window shown on the right.

2. Right click on the Local Area Network Connection you will 
    use to connect to the meter and select Properties from the 
    drop-down menu. You will see the window shown on the  
    next page.

IQ 100 Series Transducer Communication Information

The IQ 100 Series Transducer model does not include a display or buttons on the front of the meter. 
Programming and communication utilize either the RS485 connection or the optional RJ45 connection 
on the back of the meter.  Once a connection is established, Eaton Meter Configuration Software can be 
used to program the meter and communicate to IQ 100 Series slave devices. Refer to the next chapter 
for instructions on programming the meter.

Meter Connection

To provide power to the meter, attach an Aux cable to GND, L(+) and N(-). Refer to page 27.
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3. Select Internet Protocol [TCP/IP] and click the Properties button. You will see the window shown  
    below. 
 
 
 
 
 
    

4. Click the Use the Following IP Address radio button and enter these parameters:  
	 IP Address:		  10.0.0.2
	 Subnet Mask: 	 255.255.255.0

5. Click the OK button. You have completed the setup procedure.

Setting up the Ethernet Card in the IQ 100 Series meter 

Below are the Factory Default settings for the IQ 100 Series meter’s Ethernet card. These are  
programmed into the meter before it is shipped from the factory. Parameters in group 1 may need to be 
altered to satisfy the local Ethernet configuration requirements. Other parameters (2, 3, 4) should not be 
altered.
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•  The Ethernet card in the IQ 100 Series meter can be locally or remotely configured using a Telnet 
   connection over the network. 
•  The configuration parameters can be changed at any time and are retained when the meter is not  
   powered up. After the configuration has been changed and saved, the Ethernet card performs a Reset. 
•  Only one person at a time should be logged into the network port used for setting up the meter. This 
   eliminates the possibility of several people trying to configure the Ethernet interface simultaneously.
•  It is possible to reset the Ethernet card to its default values. See the procedure on the next page.

Configuring the IQ 100 Series Meter’s Ethernet Connection using Windows XP© on the Host Computer

Establish a Telnet connection on port 9999. Follow these steps: 

1. From the Windows Start menu, click Run and type ‘cmd’.

2. Click the OK button to bring up the Windows’ Command Prompt window.  

3. In the Command Prompt window, type: “telnet 10.0.0.1 9999” and press the Enter key. 
    NOTE: Make sure there is a space between the IP address and 9999.
 

    When the Telnet connection is established you will see a message similar to the example shown  
    below.

4. To proceed to Setup Mode press Enter again. You will see a screen similar to the one shown below.

5. Change ONLY the parameters in group 1. To do so:
 	 a. Type number “1.” 
 	 b. Once group 1 is selected, the individual parameters display for editing. Either:
 		  •  Enter a new parameter if a change is required.
 		  •  Press Enter to proceed to the next parameter without changing the current setting.
     IMPORTANT! Settings 2, 3, and 4 MUST have the default values shown above.
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    (Example: Setting device with static IP Address.)
       IP Address <010> 192.<000> 168.<000> .<000> .<001>
       Set Gateway IP Address <N>? Y
       Gateway IP Address: <192> .<168> .<000> .<001>
       Set Netmask <N for default> <Y>? Y

6. Continue setting up parameters as needed.  When you finish your modifications, make sure to press 
    the “S” key on the keyboard. This saves the new values and causes a Reset in the Ethernet card.
    CAUTION! DO NOT PRESS ‘D’ as it will overwrite any changes and save the default values.

IMPORTANT! If the IP Address of the Ethernet card is lost, you can restore the factory default settings 
by pressing the Reset button on the card. Follow the procedure below.

Resetting the Ethernet Card 

The Ethernet card’s Reset button is accessed from the back of the IQ 100 Series meter. See the figure 
below.

 

Using an implement such as a ballpoint pen tip, press and hold the Reset button for 30 seconds. The 
Ethernet card is reset to the default settings shown on the previous page. 

Reset Button
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Programming the IQ 100 Series Meter Using the Front Panel

Introduction

You can use the Elements and Buttons on the IQ 100 Series meter’s face to view meter readings, reset 
and/or configure the meter, and perform related functions. The following sections explain the Elements 
and Buttons and detail their use.

Understanding Meter Face Elements

The meter face features the following elements:
• Reading Type Indicator:
   Indicates type of reading
• Parameter Designator:
   Indicates reading displayed
• Watt-Hour Test Pulse:  
   Energy pulse output to test accuracy 
• Scaling Factor:
   Kilo or Mega multiplier of displayed readings
• % of Load Bar:  
   Graphic display of Amps as % of the load 

Understanding Meter Face Buttons

The meter face has Menu, Enter, Down and 
Right buttons, which allow you to perform the 
following functions:
• View meter information
• Enter display modes
• Configure parameters (may be Password protected)
• Perform resets (may be Password protected)
• Perform LED checks
• Change settings
• View parameter values
• Scroll parameter values
• View Limit states

Parameter 
Designator

Watt-Hour 
Test Pulse

Scaling 
Factor% of Load Bar

Reading Type 
Indicator

                   Meter Faceplate Elements

                   Meter Faceplate Buttons

EnterMenu

Down Right



IQ 100 Series (130/140/150) Meter
Programming the Meter Using the Front Panel

50             User and Installation Manual    IM02601003E - March 2012  www.eaton.com

Using the Front Panel 

You can access the following modes using the meter’s front panel buttons:
• Operating mode (Default mode)
• Reset mode 
• Configuration mode

Use the Menu, Enter, Down and Right buttons to navigate through each mode and its related
screens.
NOTES: 
• Appendix A contains the complete Navigation map for the front panel display modes and their screens.  
• The meter can also be configured using software (with optional communication); see the next chapter 
   for instructions.

Understanding Startup and Default Displays

Upon Power Up, the meter displays a sequence of screens:
• Lamp Test screen where all LEDs are lit
• Lamp Test screen where all digits are lit
• Firmware screen showing build number
• Error screen (if an error exists)

After startup, if auto-scrolling is enabled, the meter scrolls the parameter readings on the right side of the
front panel. The Kilo or Mega LED lights, showing the scale for the Wh, VARh and VAh readings.  The 
figure below shows an example of a Wh reading.

	

The meter continues to provide scrolling readings until one of the buttons on the front panel is pressed,
causing the meter to enter one of the other modes.
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Using the Main Menu 

1. Press the Menu button.  The Main Menu screen appears. 
   • The Reset mode (rSt) appears in the A window.  Use the Down button to scroll, causing
      the Configuration (CFG) and Operating (OPr) modes to move to the A window.
    • The mode that is currently flashing in the A window is the “Active” mode, which means it is the 
       mode that can be configured.

       For example:  Press Down Once- CFG moves to A window. Press Down Once - OPr moves to A window.

2.  Press the Enter button from the Main Menu to view the parameters screen for the mode that is 
     currently active.
  
Using Reset Mode 

Reset mode resets all of the Max and Min values in the meter. 
NOTE: With the communication options, you can reset both the Max/Min values
and the energy accumulators. If you do not have a communication option, 
you cannot reset the energy accumulator fields.

Press the Enter button while rSt is in the A window. The Reset All? No screen 
appears.  
    • If you press the Enter button again, the Main Menu appears, 
      with the next mode in the A window. (The Down button 
      does not affect this screen.)

    • If you press the Right button, the Reset All? YES screen appears. 
       Press Enter to reset the meter’s Max and Min values.
      CAUTION! Reset All? YES resets all Max and Min values. Only press Enter 
      if this is what you want to do.

      NOTE: If Password protection is enabled for Reset, you must 
      enter the four digit Password before you can reset the meter. 
      (See page 66 for information on Password Protection.)  
      To enter a password, follow the instructions on the next page.

Once you have performed a reset, the screen displays “rSt All donE” and then resumes auto-scrolling 
parameters.
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Entering a Password 

If Password protection has been enabled in the software for reset and/or configuration (see page 66 for 
information), a screen appears requesting a password when you try to reset the meter and/or configure 
settings through the front panel.  
   
     •  PASS appears in the A window and 4 dashes appear in the B window.  The leftmost dash is 
         flashing.
       
1. Press the Down button to scroll numbers from 0 to 9 for the flashing dash.  When the correct number 
    appears for that dash, use the the Right button to move to the next dash. 

     Example:  The left screen, below, shows four dashes.  The right screen shows the display after the
     first two digits of the password have been entered.

2. When all 4 digits of the password have been selected, press the Enter button.  

     •  If you are in Reset mode and the correct password has been entered, “rSt All donE” appears
        and the screen resumes auto-scrolling parameters. 
     •  If you are in Configuration mode and the correct password has been entered, the display 
        returns to the screen that required a password. 

     •  If an incorrect password has been entered, “PASS ---- FAIL” appears, and:
         •  The previous screen is redisplayed, if you are in Reset Mode. 
         •  The previous Operating Mode screen is redisplayed, if you are in Configuration Mode.
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Using Configuration Mode

Configuration Mode follows Reset: Energy in the Main Menu.   

To access Configuration mode:

1.  Press the Menu button while the meter is auto-scrolling parameters.

2.  Press the Down button until the Configuration Mode option (CFG) is in the A window.

3.  Press the Enter button. The Configuration Parameters screen appears.  

4.  Press the Down button to scroll through the configuration parameters: Scroll (SCrL), CT, PT, 
     Connection (Cnct) and Port. The parameter currently ‘Active,” i.e., configurable, flashes in the A 
     window.

5.  Press the Enter button to access the Setting screen for the currently active parameter.
     NOTE: You can use the Enter button to scroll through all of the Configuration parameters and their 
     Setting screens, in order.

                    Press Enter when CFG is in A window -        Parameter screen appears  - Press Down-
   �
6.  The parameter screen appears, showing the current settings.  To change the settings:
      • Use either the Down button or the Right button to select an option.
      • To enter a number value, use the Down button to select the number value for a digit and the Right
         button to move to the next digit. 
      NOTE:  When you try to change the current setting and Password Protection is enabled for the 
      meter, the Password screen appears. See the previous page for instructions on entering a password.

7.  Once you have entered the new setting, press the Menu button twice. 

8.  The Store ALL YES screen appears.  You can either:
      •  Press the Enter button to save the new setting. 
      •  Press the Right button to access the Store ALL no screen; then press the Enter button to cancel
         the Save.

9.  If you have saved the settings, the Store ALL done screen appears and the meter is reset.

    

         Press the Enter button to save the settings   Press the Enter button to      The settings have been saved
        Press the Right button for Stor All no screen       Cancel the save
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Configuring the Scroll Feature

When in Auto Scroll mode, the meter performs a scrolling display, showing each parameter for 7 
seconds, with a 1 second pause between parameters. The parameters the meter displays are 
determined by the following conditions:
    •  They have been selected through software (refer to the next chapter for instructions).
    •  Their availability for the meter model (IQ130/140 or 150) may be restricted.

To enable or disable auto-scrolling:

1.  Press the Enter button when SCrl is in the A window.  
     The Scroll YES screen appears.

2.  Press either the Right or Down button if you want to access the 
     Scroll no screen. 
     To return to the Scoll YES screen, press either button.

 

3.  Press the Enter button on either the Scroll YES screen (to enable auto-scrolling) or the Scroll no
     screen (to disable auto-scrolling). 
     The CT- n screen appears (this is the next Configuration mode parameter). 
	
    NOTE: 
    •  To exit the screen without changing scrolling options, press the Menu button.
    •  To return to the Main Menu screen, press the Menu button twice. 
    •  To return to the scrolling (or non-scrolling) parameters display, press the Menu button three times.
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Configuring CT Setting

The CT Setting has three parts: Ct-n (numerator), Ct-d (denominator), and Ct-S (scaling). 

1.  Press the Enter button when Ct is in the A window. 
     The Ct-n screen appears. You can either:
       •  Change the value for the CT numerator.
       •  Access one of the other CT screens by pressing the Enter button: press Enter once to access the
           Ct-d screen, twice to access the Ct-S screen. 
          NOTE: The Ct-d screen is preset to a 5 Amp or 1 Amp value at the factory and cannot be  
          changed.

   a.  To change the value for the CT numerator, from the Ct-n screen:
          • Use the Down button to select the number value for a digit. 
          • Use the Right button to move to the next digit.
   b.  To change the value for CT scaling, from the Ct-S screen:
         Use the Right button or the Down button to choose the scaling you want. The Ct-S setting can be 
         1, 10, or 100.
       NOTE: If you are prompted to enter a password, refer to the instructions earlier in the chapter.

2.  When the new setting is entered, press the Menu button twice.
      
3.  The Store ALL YES screen appears. Press Enter to save the new CT setting. 

Example CT Settings:
200/5 Amps: 			  Set the Ct-n value for 200 and the Ct-S value for 1.
800/5 Amps: 			  Set the Ct-n value for 800 and the Ct-S value for 1.
2,000/5 Amps: 		  Set the Ct-n value for 2000 and the Ct-S value for 1.
10,000/5 Amps: 		  Set the Ct-n value for 1000 and the Ct-S value for 10.

NOTES: 
• The value for Amps is a product of the Ct-n value and the Ct-S value.
• Ct-n and Ct-S are dictated by primary current; Ct-d is secondary current.

             Press Enter         Use buttons to set Ct-n value   The Ct-d can’t be changed   Use buttons to select scaling
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Configuring PT Setting

The PT Setting has three parts: Pt-n (numerator), Pt-d (denominator), and Pt-S (scaling). 

1.  Press the Enter button when Pt is in the A window. 
     The PT-n screen appears. You can either:
       •  Change the value for the PT numerator.
       •  Access one of the other PT screens by pressing the Enter button: press Enter once to access the
          Pt-d screen, twice to access the Pt-S screen.

   a.  To change the value for the PT numerator or denominator, from the Pt-n or Pt-d screen:
          •  Use the Down button to select the number value for a digit.
          •  Use the Right button to move to the next digit.
   b.  To change the value for the PT scaling, from the Pt-S screen:
         Use the Right button or the Down button to choose the scaling you want. The Pt-S setting can be
         1, 10, 100, or 1000.
        NOTE: If you are prompted to enter a password, refer to the instructions earlier in this chapter.

2.  When the new setting is entered, press the Menu button twice.

3.  The STOR ALL YES screen appears. Press Enter to save the new PT setting.

Example Settings:
277/277 Volts: 			   Pt-n value is 277, Pt-d value is 277, Pt-S value is 1.
14,400/120 Volts: 			   Pt-n value is 1440, Pt-d value is 120, Pt-S value is 10.
138,000/69 Volts: 			   Pt-n value is 1380, Pt-d value is 69, Pt-S value is 100.
345,000/115 Volts:			   Pt-n value is 3450, Pt-d value is 115, Pt-S value is 100.
345,000/69 Volts: 			   Pt-n value is 345, Pt-d value is 69, Pt-S value is 1000.

NOTE: Pt-n and Pt-S are dictated by primary voltage; Pt-d is secondary voltage.

   Use buttons to set Pt-n value      Use buttons to set Pt-d value   Use buttons to select scaling 
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Configuring Connection Setting

1.  Press the Enter button when Cnct is in the A window. The Cnct screen appears.

2.  Press the Right button or Down button to select a configuration. 
     The choices are:
      • 3 Element Wye (3 EL WYE)
      • 2.5 Element Wye (2.5EL WYE)
      • 2 CT Delta (2 Ct dEL)
     NOTE: If you are prompted to enter a password, refer to the  
     instructions earlier in this chapter.

3.  When you have made your selection, press the Menu button twice.

4.  The STOR ALL YES screen appears. Press Enter to save the setting. 

           �
Configuring Communication Port Setting

Port configuration consists of : Address (a three digit number), Baud Rate (9600; 19200; 38400; or 
57600), and Protocol (Modbus RTU or Modbus ASCII).

1.  Press the Enter button when POrt is in the A window. 
     The Adr (address) screen appears.  You can either:  
       • Enter the address.
       • Access one of the other Port screens by pressing the Enter button: press Enter once to access the
          bAUd screen (Baud Rate); press Enter twice to access the Prot screen (Protocol).
        a.  To enter the Address, from the Adr screen:
               •  Use the Down button to select the number value for a digit.
               •  Use the Right button to move to the next digit.
        b.  To select the Baud Rate, from the bAUd screen:
              Use the Right button or the Down button to select the setting you want.
        c.  To select the Protocol, from the Prot screen:
              Press the Right button or the Down button to select the setting you want.
             NOTE: If you are prompted to enter a password, refer to the instructions earlier in this chapter.

2.  When you finish making your selections, press the Menu button twice.

3.  The STOR ALL YES screen appears. Press Enter to save the settings.

Use buttons to enter Address    Use buttons to select Baud Rate    Use buttons to select Protocol
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Using Operating Mode

Operating Mode is the IQ 100 Series meter’s default mode, that is, the standard front panel display.  
After Startup, the meter automatically scrolls through the parameter screens, if scrolling is enabled.  
Each parameter is shown for 7 seconds, with a 1 second pause between parameters.  Scrolling is sus-
pended for 3 minutes after any button is pressed.	

1. Press the Down button to scroll all the parameters in Operating Mode. The currently “Active,” i.e., 
    displayed, parameter has the Indicator light next to it, on the right face of the meter.

2. Press the Right button to view additional readings for that parameter. The table below shows possible
    readings for Operating Mode. Sheet 2 in Appendix A shows the Operating Mode Navigation map.
    NOTE: Readings or groups of readings are skipped if not applicable to the meter type or hookup, or if
    they are disabled in the programmable settings.

Operating Mode Parameter Readings

                                                                                     POSSIBLE READINGS
VOLTS L-N VOLTS_LN VOLTS_LN_

MAX
VOLTS_LN_
MIN

VOLTS L-L VOLTS_LL VOLTS_LL_
MAX

VOLTS_LL_
MIN

AMPS AMPS AMPS_NEU-
TRAL

AMPS_MAX AMPS_MIN

W/VAR/PF W_VAR_PF W_VAR_PF_
MAX_POS

W_VAR_PF_
MIN_POS

W_VAR_PF_
MIN_NEG

VA/Hz VA_FREQ VA_FREQ_
MAX

VA_FREQ_
MIN

Wh KWH_REC KWH_DEL KWH_NET KWH_TOT
VARh KVARH_POS KVARH_

NEG
KVARH_NET KVARH_

TOT
VAh KVAH
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Understanding the % of Load Bar

The 10-segment LED bar graph at the bottom left of the IQ 100 Series front panel provides a graphic 
representation of Amps.  The segments light according to the load, as shown in the table below.  
When the Load is over 120% of full load, all segments flash “On” (1.5 secs) and “Off” (0.5 secs).

% of Load Segment Table
Segments Load >= % Full Load

none no load
1 1%

1-2 15%
1-3 30%
1-4 45%
1-5 60%
1-6 72%
1-7 84%
1-8 96%
1-9 108%
1-10 120%

All Blink >120%

% of Load Bar
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Performing Watt-Hour Accuracy Testing (Verification)

To be certified for revenue metering, power providers 
and utility companies must verify that the billing energy 
meter performs to the stated accuracy.  To confirm the 
meter’s performance and calibration, power providers use 
field test standards to ensure that the unit’s energy 
measurements are correct.  Since the IQ 100 Series meter is a 
traceable revenue meter, it contains a utility grade test pulse 
that can be used to gate an accuracy standard.  This is an 
essential feature required of all billing grade meters. 

•  Refer to the figure below for an example of how this process works.

•  Refer to the table below for the Wh/Pulse constants for accuracy testing.

 Infrared & KYZ Pulse Constants for Accuracy Testing - Kh Watt-hour per pulse
	

Input Voltage Level Class 10 Models Class 2 Models
                 Below 150V                    0.2505759630                     0.0501151926
                 Above 150V                   1.0023038521                     0.2004607704

NOTES: 
	 •  Minimum pulse width is 40 milliseconds.
	 •  Refer to the Pulse specifications in the Overview and Specifications chapter.

      Using the Watt-Hour Test Pulse

Watt-Hour 
Test Pulse
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Programming the IQ 100 Series Meter Using Software
Overview

The IQ 100 Series meter can be configured using either the meter’s faceplate buttons (Menu, Enter, 
Down and Right) or Eaton Meter Configuration software. To connect to the meter for software configu-
ration, use the RS485 port, if equipped, on the back panel of the meter, or the RJ45 port if the meter 
has the Ethernet card option. 
The IQ 100 Series Transducer must be configured with the Eaton Meter Configuration software, using 
either the RS485 port or the optional RJ45 port, since it does not have a front panel.

This chapter contains instructions for programming the meter and Transducer using software.

Connecting to the IQ 100 Series Meter/Transducer

1. Open Eaton Meter Configuration software.

2. Click the Connect icon on the Title bar or 
    Connection>Quick Connect. 

3. If you are connecting to the meter through your PC: 
    a. Make sure the Serial Port radio button is selected. 
    b. Enter Device Address (1-247).
    c. Select Baud Rate from the pull-down menu.
    d. Select the port you are using from the pull-down menu. The 
        Available Ports/All Ports radio buttons determine which port 
        selections  the menu displays.
    e. Select Modbus RTU from the Protocol pull-down menu.
    f. Select Flow Control: None or Hardware.
    g. Select Echo Mode: No Echo or Static Echo.
   If you are connecting to the meter through the Power Xpert® Gateway 
    or through the RJ45 port option: 
    a. Make sure the Network radio button is selected. 
    b. Enter Device Address (1-247).
    c. Enter the Gateway or the meter’s Ethernet card IP Address.
    d. Enter Network Port (502 for Modbus).
    e. Protocol defaults to Modbus TCP.

4. Click the Connect button. You will see the Device Status
    screen, shown below on the right.

NOTE for IQ 100 Series Transducer:
When the Transducer is powered up, for 10 
seconds you can connect to the meter using the 
Factory Initial Default Settings (even if the Device 
Profile has been changed). After 10 seconds,
the Device Profile reverts to the actual Device 
Profile in use.  

Factory Initial Default Settings
Baud Rate:		  9600
Port:			   COM1                                                                                        
Protocol:		  Modbus RTU



IQ 100 Series (130/140/150) Meter
Programming the IQ 100 Series Using Software

62             User and Installation Manual    IM02601003E - March 2012  www.eaton.com

IQ 100 Series (130/140/150) Meter
Programming the IQ 100 Series Using Software

Accessing the IQ 100 Series Device Profile

1. Click the Profile icon in the Title Bar. 

2. You will see the IQ 100 Device Profile screen. The tabs   
    at the top of the screen allow you to navigate between
    Settings screens. The Buttons at the bottom of the screen allow you to perform tasks, for 
    example, updating the Device Profile. See the example screen below.

.            

   

Settings Screen

 

      Buttons

	

3. To select a setting, click on its tab at the top of the screen. This causes the Settings screen to be 
    displayed. See the following sections for instructions on configuring meter settings.

       Tabs
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IQ 100 Series ((130/140/150) Meter
Programming the IQ 100 Series Meter Using Software

Performing Device Profile Tasks

You can perform the following tasks using the Device Profile screen buttons. 

Update: Click to send the current settings to the meter. •	

     NOTE: You must click the Update Device button after making changes in the Settings screens, if you
     want to update the connected meter’s settings.

Cancel: Click to leave the Device Profile Editor screen without •	
     saving any changes.

Load: Click to load a previously saved Device Profile •	
     settings file. You will see the Load Programmable Settings 
     window, shown on the right. 
     Select the saved Device Profile you want and click Open. 
     The settings from that file now appear in the Settings 
     screens; for example, the CT and PT Ratios will be those 
     from the saved Device Profile, rather than from the 
     currently connected meter.

Save: Click to save the Device Profile settings to a file. You•	
     will see the Save Programmable Settings window, shown on
     the right. Give a name to the Device Profile file and click  
     Save.

Report: Click to open a Notepad window containing the •	
     Device Profile settings in a text file. See the example 
     window, shown on the right. 
	 •  Print the text file by selecting File>Print from the 
	     Notepad Title Bar.
	 •  Save the text file by selecting File>Save from the 
	     Notepad Title Bar.
    NOTE: When you click Report, you will be given the choice  
    of viewing the Device Profile report or printing the report  
    without viewing it on the screen.

	 ·	



IQ 100 Series (130/140/150) Meter
Programming the IQ 100 Series Using Software

64             User and Installation Manual    IM02601003E - March 2012  www.eaton.com

Configuring Settings

The following sections contain detailed instructions for configuring the Device Profile settings. All of the 
settings are reached from tabs at the top of the Device Profile screen. 

Configuring Scaling

Use this setting to configure Current Transformer and Potential Transformer ratios and to select the 
wiring (System Hookup). 

Functional Overview of CT and PT Ratios

Current and Potential transformers are used mainly for the following reasons:
To insulate, and as a result isolate, the meter from high-voltage circuits•	
To change the primary voltage and current to standard values and sizes that the meter can measure.•	

The CT and PT transformers deliver fractions of the primary voltage and current to the meter. With 
properly set ratios and multipliers, the readings of the meter can be used to determine the energy, 
voltage, current, or power of the system. 

This setting is the first screen displayed when you open the IQ 100 Series Device Profile. If you have 
been on another screen, click the Scaling tab to re-display this screen. The screen fields and acceptable 
entries are as follows:

CT Ratios

CT Numerator (Primary): 1 - 9999
CT Denominator (Secondary): 5 or 1 Amp 
NOTE: This field is display only.
CT Multiplier (Scaling): 1, 10 or 100
Current Full Scale: Display only. 

PT Ratios
PT Numerator (Primary): 1 - 9999
PT Denominator (Secondary): 40 - 600
PT Multiplier (Scaling): 1, 10, 100, or 1000
Voltage Full Scale: Display only. 

System Wiring
3 Element Wye; 2.5 Element Wye; 2 CT Delta

Example Settings:

For a CT of 2000/5A, set the following CT Ratios in the entry fields:
CT Numerator (Primary)		     2000
CT Denominator (Secondary)    	    5
CT Multiplier		        		     1
The Current Full Scale field will read 2000. 
NOTE: You can obtain the same Current Full Scale by entering a CT Numerator of 200 and a CT 
Multiplier of 10.
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For a system that has 14400V primary with a 120V secondary line to neutral (PT Ratio of 120:1), set 
the following PT Ratios in the entry fields:
PT Numerator (Primary) 		       1440
PT Denominator (Secondary)	      120
PT Multiplier		         		       10
The Voltage Full Scale field will read 14400.

Configuring Energy and Display Settings

Click the Energy and Display tab. You will see the screen shown on 
the right. It displays the current settings for Power and Energy format, 
Demand averaging (IQ140 and above), auto-scrolling and display 
configuration. The screen fields and acceptable entries are as 
follows:

Power and Energy Format

Power Scale: Unit, kilo (k), Mega (M), Auto 
Energy Digits: 5, 6, 7, 8
Decimal Places: 0 - 6
Energy Scale: Unit, kilo (k), Mega (M)
Example: Shows an example of selected settings. 
Power Direction: View as Load or View as Generator
NOTES: 

The Energy Digits, Scale and Decimal Places settings determine how the Energy values are displayed.•	
If invalid values are entered, you will see the following warning message:  •	
“Warning: Current CT, PT and Energy Settings may cause invalid energy accumulator values.”  
Once you correct the values and click Recalculate this message goes away.

Demand Averaging  (IQ140/150 only)
	
Average Method: Fixed or Sliding  
Interval: 5, 15, 30 or 60 Minutes
Subinterval: 1, 2, 3 or 4
NOTE: Fixed Average cannot have a subinterval.

Auto Scroll Display

Clicking the checkbox turns auto-scrolling On and Off. Auto-scrolling controls the display of selected 
parameters on the meter’s faceplate. 

Display Configuration  

Check the boxes of the Readings you want displayed on the faceplate of the meter.  You must select at 
least one reading.
NOTE: This setting can be ignored for the IQ100 Series transducer, since it doesn’t have a display.
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Configuring Communication Settings

Use this setting to configure communication settings for the meter’s RS485 Port.

NOTES: 
•  The settings on this screen are the current settings for communication.
•  Any changes may affect communication between the meter and your PC. 

Click the Communication tab. You will see the screen shown on the
right. The screen fields and acceptable entries are as follows:

COM 2 (RS485)
Address:		  1 - 247
Protocol:		  Modbus RTU, Modbus ASCII or DNP 3.0
Baud Rate: 		  57600
Response Delay: 	 0 - 750 (50 msec increments)
NOTE: Response Delay is the delay the meter should use before 
responding to queries. If your connecting device requires a delay 
before receiving information, use response delay to program the time 
to wait before the meter starts responding to queries.

Configuring (System) Settings 

Use this setting to configure meter password or assign a meter designation. 

Click the Settings tab. You will see the screen shown on the right.

To enable or disable Password protection for reset and/or  •	
configuration: 

     Click the checkbox next to the option. Enabling Password 
     protection prevents unauthorized tampering with devices. 

     IMPORTANT! You must set up a password before enabling 
     Password protection. Click the Change button next to Change 
     Password if you have not already set up a password.

To Change the device designation: input a new designation into •	
     this field.

When you click the Change button next to Change Password 
in the Settings screen, you will see the message window shown on
the right.

1.  Type in the new password (0 - 9999).  

2.   Retype the password.
	
3.   Click Change.  The new password is saved and the meter restarts.

4.  You can now enable the password for reset (Reset Max/Min Energy Settings) or configuration 
     (Device Profile) by clicking the checkbox next to the option.

When a user attempts to make a change that is under Password protection, the Eaton Meter Configura-
tion software opens a message window asking for the password. If the correct password is not entered, 
the change does not take place.
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Polling the IQ 100 Series Meter

The Real Time Poll features of Eaton Meter Configuration software are used to continuously view 
instantaneous values within an IQ 100 Series meter.  The software provides tabular views of metered 
values, circuit measurements, interval data, and pulse data.

The Real Time Poll features are divided into three groups, accessed by clicking Real-Time Poll in the Title 
Bar: 

     •  Real Time Readings
     •  Revenue, Energy and Demand Readings
     •  Power Quality 

     
 

     When you click Real Time Readings; Revenue, Energy and Demand Readings; and Power Quality and
     Alarms, you will see a sub-menu that allows you to select individual polling screens. 

NOTE: Clicking the Polling icon on the Title Bar is the same as selecting Instantaneous Polling from the 
Real-Time Poll>Real Time Readings menu; clicking the Phasors icon on the Title Bar is the same as 
selecting Phasors from the Real-Time Poll>Power Quality and Alarms menu.

Instantaneous Polling

Click Real-Time Poll>Real Time Readings>Instantaneous Polling. You will see the screen shown below.
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Click Print to print a copy of the screen.•	
Click Help to view instructions for this screen. •	
Click OK to return to the main screen.•	

Poll Power and Demand

Click Real-Time Poll>Revenue, Energy and Demand Readings>Power and Demand. You will see the 
screen shown below.

Click Print to print a copy of the screen.•	
Click Help to view instructions for this screen. •	
Click OK to return to the main screen.•	
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Poll Phasors

Click Real Time Poll>Power Quality and Alarms>Phasors. You will see the screen shown below.

The Phasors screen displays the Phase relationships of the currently connected meter. If you have an 
auxiliary voltage reading (i.e. generator and bus where the VAux is the generator), the Aux box and the 
VAux phasor are displayed.  The VAux phasor is referenced to VA phase.

To adjust the Phasor display, click Options at the bottom of the screen.
    You will see the screen shown on the right.

    a. In the Display Angles Increasing and Phasor Rotation boxes, 
        select either Clockwise or Counter Clockwise.

    b. From the pull-down menu at the bottom of the screen, select 
        Vectors, Triangles or Vectors and Triangles to change the 
        graphic representation of the data.

Click OK to save your selections and return to the Phasors screen.  
 

Click Copy to save a copy of the screen to the clipboard.•	
Click Print to send a copy of the graph to a printer.•	
Click Help to view instructions for this screen.•	
Click OK to return to the main screen.•	
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Using the IQ 100 Series Tools Menu

The Tools Menu allows you to access specific functions 
for the IQ 100 Series Meter. Click Tools from the Title Bar 
to display the Tools Menu.

Accessing the Device Profile Screen

Click the first option, Edit Current Device Profile, to open 
the Device Profile screen. This menu option performs the 
same function as clicking the Profile icon in the Title Bar.

Reset Device Information

Click this option to reset either Max/Min values (IQ 130, IQ 140,
and IQ 150 meters) and/or Energy Accumulators (IQ 150 only). 
You will see the screen shown on the right. Click the checkbox 
next to the item(s) you want to reset.

Retrieve Device Status

Click this option to see the Device status screen for the meter. this is the same screen that displays 
when you first connect to the meter. 
 
Flash Update Firmware

Click this option to upgrade the meter’s firmware. You will
see the screen on the right.

Click Browse to locate the flash file.

Click OK to update the firmware with the flash file. When 
flashing is complete, click Exit to close the screen.

NOTE: Flash updating of firmware can only be done at a Baud 
Rate of 57.6k.
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Performing Additional Tasks with Eaton Meter Configuration Software 

The following sections contain instructions for other tasks you can perform using the Eaton Meter 
Configuration software.

Using Connection Manager

Use Connection Manager to add or remove connection 
locations and/or devices at locations. 

1. Click Connection>Connection Manager or click on the 
    Connect Mgr icon. You will see the screen shown on 
    the right.

List of Locations:  

On the left side of the Connection Manager screen is a List 
of Locations. These are the locations of one or more 
meters to which you can connect. You can add a location
and/or a device; edit a location and/or device; or remove
a location and/or device.

• To add a location:   
   a. Click on the Add button. You will see the Connection 
       Manager Location Editor screen.  On this screen, 
       you program the Communication settings for each 
       new location.  
   b. Type a name for the new location. 
   c. Click Serial Port or Network.  
   d. Enter Communication settings:

	 Com Port: 		  COM 1 - 99
	 Baud Rate: 		  1200 - 115200
	 Flow Control: 	 None or Hardware
	 Data Bits: 		  8 (or 7)
	 Parity:  		  None (Even, Odd)

   e. To add a device:  
        -  Click Add Serial (to add a Serial Port connected 
	  device) or Add Net (to add a Network connected device) in the Devices at Location box. You
	  can add up to 255 devices (Serial Port and/or Network connected) at one location.  
 
   NOTES: 
   • All devices must have the same connection parameters: Baud, Parity and Flow Control.
   • Multiple devices slow down polling.
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	     f.  To edit a device:
 	         -  Select the device from the Devices at Location box. (Scroll 
		   down to find all devices.)
 	         -  Click Edit. You will see the Connection Manager Location
	            Device Editor screen, shown on the right. 
	         -  Use this screen to program the device properties for each 
		   device at a location.
	     	 • If the device has a Serial Port device connection, you will 
		    see the first (top) example screen.
	    	 • If the device has a Network device connection, you will 
		    see the second example screen. 
	     	   NOTE: Click the Network or Serial button at the top of the 
		    screen to switch connection screens.		   
	         -  Enter Device Properties:
		     Address: 		  1 - 247 (Unique Address)
		     Name: 		  Device Name
		     Description: 	 (Type and Number, for example)
		     Protocol:  		  Modbus RTU, ASCII, or Modbus TCP 
		     Device Type: 	 IQ Meter
		     Comm Port: 	 1 or 2 (Serial Port Only)
		     IP Address:		 100.10.10.10 (for example) (Network  
					     Only)
		     Port Number:	 502 (Default) (Network Only)

                  -  Click Close to save settings and return to the Connection 
	            Manager Location Editor screen. 
             g.  To remove a device, select the device from the Devices at Location box and click Remove. 
             h.  Click Close to return to the Connection Manager screen.

• To edit a location:
   a.  Select a location from the List of Locations box.  
   b.  Click the Edit button. The Connection Manager Location Editor screen appears, displaying the current 
        settings for the location. 
   c.  Make any changes to settings and/or devices at the location.
   d.  Click Close to exit the screen.

• To remove a location:
   a.  Select a location from the List of Locations box.
   b.  Click Remove. 
   c.  Click Yes in the Confirmation window.

• To sort the list of locations:
   a.  Select a sort method (A-Z, Z-A, Newest-Oldest or Oldest-Newest) from the pull-down menu.  
   b.  Click Sort By.  
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• To connect to a location:
   a.  Select the location you want to connect to from the List of Locations box. 

   NOTE: You may only connect to one location at a time. To change to a different location, you must 
   disconnect from the current location by selecting it and clicking Disconnect.

   b.  Click Connect. When the connection is made, the selected location appears in the Connected To 
        Locations section of the screen. 
   c.  Click Close. The Device Status screen opens, confirming the connection. The computer Status bar
        at the bottom of the screen also confirms the computer’s connection parameters.

NOTE: If the connection fails, a popup screen alerts you.  Check that all cables are secure, that the 
RS232 cable is connected to the correct Com Port on the computer, and that the computer is set to use 
the same baud rate and protocol as the meter to which the computer is connected.

Disconnecting from an IQ 100 Series meter 

To disconnect from an IQ 100 Series meter or from a location, do one of the following:
•  Click on the Disconnect icon in the Title Bar.

•  Select Connection>Disconnect from the Title Bar.

•  From the Connection Manager screen, select the location from the Connected to Location field and
   click the Disconnect button.

Changing the Primary Device/Address

Use this feature to select another meter as the primary device.

1. Click Connect>Change Primary Device/Address. You will 
    see the screen on the right.

2. Enter the address of the device you want to designate as the 
    new Primary Device.

3. Click OK.

Merging Connection Databases

Use this feature to combine two sets of cnexcom databases.

1. Click Connection>Merge Connection Databases. You will 
    see the screen on the right. It allows you to select the two 
    databases to merge.

2. Click the Browse button next to each field to pick the 
    databases. The Source cnexcom database will be merged  
    into the Destination cnexcom database.

3. Click the Merge button to proceed with the merge; click OK 
      to exit the screen.
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Using the Options Screen

1. Click View>Options. You will see the screen shown on
    the right. Use this screen to access the following
    features:
	 • Paths for Eaton Meter Configuration software files
	 • Data Scan mode
    Use the tabs at the top of the screen to access these 
    features.

2. The first Options screen is the Paths screen, shown on 
    the right. Use this screen to view or change the paths 
    the Eaton Meter Configuration software uses for data.

3. Click the Data Scan Mode tab to see the second screen 
    on the right. Use this screen to select normal scan rate
    or to enter a custom scan rate.

4. Click:
	 •  Apply to apply your selection(s) and keep the 
	    Options screen open 
	 •  Okay to apply your selection and close the 
	     Options screen 
	 •  Cancel to close the Options screen without 
	     saving any selections that have not been applied

Using the Help Menu

The Help menu, accessed by clicking Help in the Title Bar, allows you to:
•  View this manual online: click Help>this User Manual.
•  View information about the Eaton Meter Configuration software, including version number: click 
    Help>About Eaton Meter Configuration Software.
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App. A: IQ 100 Series Navigation Maps

Introduction

You can configure the IQ 100 Series meter and perform related tasks using the buttons on the meter 
face.  This appendix contains the Navigation maps for the meter’s front panel displays.

Navigation Maps (Sheets 1 to 4)

The IQ 100 Series Navigation maps begin on the next page.  The maps show in detail how to move 
from one screen to another and from one display mode to another using the buttons on the face of the 
meter.  All display modes automatically return to Operating mode after 10 minutes with no user  
activity.

Navigation map titles:

• Main Menu screens (Sheet 1)
• Operating mode screens (Sheet 2)
• Reset mode screens (Sheet 3)
• Configuration mode screens (Sheet 4)



IQ 100 Series (130/140/150) Meter
App A: Navigation Maps

76             User and Installation Manual    IM02601003E - March 2012  www.eaton.com



IQ 100 Series ((130/140/150) Meter
App A: Navigation Maps

User  and Installation Manual   IM02601003E - March 2012 www.eaton.com                 77



IQ 100 Series (130/140/150) Meter
App A: Navigation Maps

78             User and Installation Manual    IM02601003E - March 2012  www.eaton.com



IQ 100 Series ((130/140/150) Meter
App A: Navigation Maps

User  and Installation Manual   IM02601003E - March 2012 www.eaton.com                 79



IQ 100 Series (130/140/150) Meter
App A: Navigation Maps

80             User and Installation Manual    IM02601003E - March 2012  www.eaton.com



IQ 100 Series ((130/140/150) Meter
App B: Modbus Map

User  and Installation Manual   IM02601003E - March 2012  www.eaton.com                 81

App.B: Modbus Mapping for the IQ 100 Series

Introduction

The Modbus map for the IQ 100 Series meter gives details and information about the possible readings 
of the meter and its programming.  

Modbus Register Map Sections

The IQ 100 Series Modbus register map includes the following sections:

Fixed Data Section, Registers 1- 47, details the meter’s Fixed Information.

Meter Data Section, Registers 1000 - 12031, details the meter’s readings, including Primary readings, 
Energy Block, Demand Block (IQ 140/150 meter), Phase Angle Block, Status Block, and Minimum and 
Maximum readings.  

Commands Section, Registers 20000 - 26011, details the meter’s Resets Block, Programming Block, 
Other Commands Block and Encryption Block.

Programmable Settings Section, Registers 30000 - 33575, details all the setups you can program to  
configure your meter.

Secondary Readings Section, Registers 40001 - 40100, details the meter’s Secondary readings.

Data Formats

ASCII:			  ASCII characters packed 2 per register in high, low order and without any
                              termination characters. 

SINT16/UINT16:	 16-bit signed/unsigned integer.

SINT32/UINT32:	 32-bit signed/unsigned integer spanning 2 registers.  The lower-addressed 
			   register is the high order half.

FLOAT:		  32-bit IEEE floating point number spanning 2 registers.  The lower-addressed 
			   register is the high order half (i.e., contains the exponent).
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Floating Point Values

Floating Point Values are represented in the following format:
Regis-
ter

0 1

Byte 0 1 0 1
Bit 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

Mean-
ing

s e e e e e e e e m m m m m m m m m m m m m m m m m m m m m m m

sign exponent mantissa

The formula to interpret a Floating Point Value is: -1sign x 2 exponent-127x1.mantissa = 0x0C4E11DB9
-1sign x 2 137-127 x 1• 1000010001110110111001
-1 x 210 x 1.75871956
-1800.929

Regis-
ter

0x0C4E1 0x01DB9

Byte 0x0C4 0x0E1 0x01D 0x0B9
Bit 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

Mean-
ing

s e e e e e e e e m m m m m m m m m m m m m m m m m m m m m m m

sign exponent mantissa

1 0x089 + 137 0b011000010001110110111001

Formula Explanation: 

	 C4E11DB9 (hex)		  11000100 11100001 00011101 10111001 (binary)

	 The sign of the mantissa (and therefore the number) is 1, which represents a negative
            value.

	 The Exponent is 10001001 (binary) or 137 decimal.
	 The Exponent is a value in excess 127.  So, the Exponent value is 10.

	 The Mantissa is 11000010001110110111001 binary.
	 With the implied leading 1, the Mantissa is (1).C23B72 (hex).

	 The Floating Point Representation is therefore -1.75871956 times 2 to the 10.

	 Decimal equivalent: -1800.929

NOTES: 	
• Exponent = the whole number before the decimal point.
• Mantissa = the positive fraction after the decimal point.
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Important Note Concerning the IQ 100 Series Modbus Map

In depicting Modbus Registers (Addresses), the IQ 100 Series meter’s Modbus map uses Holding 
Registers only.

Hex Representation

The representation shown in the table below is used by developers of Modbus drivers and libraries, SEL 
2020/2030 programmers and Firmware Developers.  The meter’s Modbus map also uses this representa-
tion. 

 
Hex	 Description
0008 – 000F	Meter Serial Number

Decimal Representation

The meter’s Modbus map defines Holding Registers as (4X) registers. Many popular SCADA and HMI 
packages and their Modbus drivers have user interfaces that require users to enter these Registers start-
ing at 40001.  So instead of entering two separate values, one for register type and one for the actual 
register, they have been combined into one number.

The meter’s Modbus map uses a shorthand version to depict the decimal fields -i.e., not all of the digits 
required for entry into the SCADA package UI are shown. 

For example: 

You need to display the meter’s serial number in your SCADA application. The meter’s Modbus map 
shows the following information for meter serial number:

Decimal	 Description
9 – 16		 Meter Serial Number

In order to retrieve the meter’s serial number, enter 40009 into the SCADA UI as the starting register, 
and 8 as the number of registers.

In order to work with SCADA and Driver packages that use the 40001 to 49999 method for request-•	
ing holding registers, take 40000 and add the value of the register (Address) in the decimal column of 
the Modbus Map. Then enter the number (e.g., 4009) into the UI as the starting register.
For SCADA and Driver packages that use the 400001 to 465536 method for requesting holding reg-•	
isters take 400000 and add the value of the register (Address) in the decimal column of the Modbus 
Map. Then enter the number (e.g., 400009) into the UI as the starting register. The drivers for these 
packages strip off the leading four and subtract 1 from the remaining value. This final value is used 
as the starting register or register to be included when building the actual modbus message.

Modbus Register Map (MM-1 to MM-16)

The IQ 100 Series Modbus register map begins on the following page.
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Description1 Format Range6
Units or 

Resolution Comments
# 

Reg

read-only
0000 - 0007 1 - 8 Reserved none 8
0008 - 000F 9 - 16 Meter Serial Number ASCII 16 char none 8
0010 - 0010 17 - 17 Meter Type UINT16 bit-mapped -------t -------- t = transducer model (1=yes, 0=no) 1

0011 - 0012 18 - 19 Firmware Version ASCII 4 char none 2
0013 - 0013 20 - 20 Map Version UINT16 0 to 65535 none 1
0014 - 0014 21 - 21 Meter Configuration UINT16 bit-mapped -------- --ffffff

ffffff = calibration frequency (50 or 60)
1

0015 - 0015 22 - 22 ASIC Version UINT16 0-65535 none 1
0016 - 0026 23 - 39 Reserved 17
0027 - 002E 40 - 47 Reserved 8

Block Size: 47

read-only
0383 - 0384 900 - 901 Watts, 3-Ph total FLOAT -9999 M to +9999 M watts 2

0385 - 0386 902 - 903 VARs, 3-Ph total FLOAT -9999 M to +9999 M VARs 2

0387 - 0388 904 - 905 VAs, 3-Ph total FLOAT -9999 M to +9999 M VAs 2

Block Size: 6

read-only
03E7 - 03E8 1000 - 1001 Volts A-N FLOAT 0 to 9999 M volts 2
03E9 - 03EA 1002 - 1003 Volts B-N FLOAT 0 to 9999 M volts 2
03EB - 03EC 1004 - 1005 Volts C-N FLOAT 0 to 9999 M volts 2
03ED - 03EE 1006 - 1007 Volts A-B FLOAT 0 to 9999 M volts 2
03EF - 03F0 1008 - 1009 Volts B-C FLOAT 0 to 9999 M volts 2
03F1 - 03F2 1010 - 1011 Volts C-A FLOAT 0 to 9999 M volts 2
03F3 - 03F4 1012 - 1013 Amps A FLOAT 0 to 9999 M amps 2
03F5 - 03F6 1014 - 1015 Amps B FLOAT 0 to 9999 M amps 2
03F7 - 03F8 1016 - 1017 Amps C FLOAT 0 to 9999 M amps 2
03F9 - 03FA 1018 - 1019 Watts, 3-Ph total FLOAT -9999 M to +9999 M watts 2
03FB - 03FC 1020 - 1021 VARs, 3-Ph total FLOAT -9999 M to +9999 M VARs 2
03FD - 03FE 1022 - 1023 VAs, 3-Ph total FLOAT -9999 M to +9999 M VAs 2
03FF - 0400 1024 - 1025 Power Factor, 3-Ph total FLOAT -1.00 to +1.00 none 2
0401 - 0402 1026 - 1027 Frequency FLOAT 0 to 65.00 Hz 2

Primary Readings Block, 6 cycles (IEEE Floating Point)

Modbus Address

Fixed Data Section

Hex Decimal

Identification Block

Meter Data Section 2

Primary Readings Block, 60 cycles (IEEE Floating Point)
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Description1 Format Range6
Units or 

Resolution Comments
# 

Reg

Modbus Address

Hex Decimal
0403 - 0404 1028 - 1029 Neutral Current FLOAT 0 to 9999 M amps 2

Block Size: 30

read-only
044B  - 044C 1100  - 1101 W-hours, Received SINT32 0 to 99999999 or            

0 to -99999999
Wh per energy format * Wh received & delivered always have 

opposite signs
2

044D - 044E 1102 - 1103 W-hours, Delivered SINT32 0 to 99999999 or            
0 to -99999999

Wh per energy format 2

044F - 0450 1104 - 1105 W-hours, Net SINT32 -99999999 to 99999999 Wh per energy format 2
0451 - 0452 1106 - 1107 W-hours, Total SINT32 0 to 99999999 Wh per energy format * 5 to 8 digits 2
0453 - 0454 1108 - 1109 VAR-hours, Positive SINT32 0 to 99999999 VARh per energy format

* decimal point implied, per energy format
2

0455 - 0456 1110 - 1111 VAR-hours, Negative SINT32 0 to -99999999 VARh per energy format 2

0457 - 0458 1112 - 1113 VAR-hours, Net SINT32 -99999999 to 99999999 VARh per energy format 2

0459 - 045A 1114 - 1115 VAR-hours, Total SINT32 0 to 99999999 VARh per energy format 2

045B - 045C 1116 - 1117 VA-hours, Total SINT32 0 to 99999999 VAh per energy format
* see note 10

2

Block Size: 18

read-only
07CF  - 07D0 2000  - 2001 Amps A, Average FLOAT 0 to 9999 M amps 2
07D1 - 07D2 2002 - 2003 Amps B, Average FLOAT 0 to 9999 M amps 2
07D3 - 07D4 2004 - 2005 Amps C, Average FLOAT 0 to 9999 M amps 2
07D5 - 07D6 2006 - 2007 Positive Watts, 3-Ph, Average FLOAT -9999 M to +9999 M watts 2
07D7 - 07D8 2008 - 2009 Positive VARs, 3-Ph, Average FLOAT -9999 M to +9999 M VARs 2
07D9 - 07DA 2010 - 2011 Negative Watts, 3-Ph, Average FLOAT -9999 M to +9999 M watts 2
07DB - 07DC 2012 - 2013 Negative VARs, 3-Ph, Average FLOAT -9999 M to +9999 M VARs 2
07DD - 07DE 2014 - 2015 VAs, 3-Ph, Average FLOAT -9999 M to +9999 M VAs 2
07DF - 07E0 2016 - 2017 Positive PF, 3-Ph, Average FLOAT -1.00 to +1.00 none 2
07E1 - 07E2 2018 - 2019 Negative PF, 3-PF, Average FLOAT -1.00 to +1.00 none 2

Block Size: 20

read-only
0BB7  - 0BB8 3000  - 3001 Volts A-N, Minimum FLOAT 0 to 9999 M volts 2
0BB9 - 0BBA 3002 - 3003 Volts B-N, Minimum FLOAT 0 to 9999 M volts 2
0BBB - 0BBC 3004 - 3005 Volts C-N, Minimum FLOAT 0 to 9999 M volts 2
0BBD - 0BBE 3006 - 3007 Volts A-B, Minimum FLOAT 0 to 9999 M volts 2
0BBF - 0BC0 3008 - 3009 Volts B-C, Minimum FLOAT 0 to 9999 M volts 2

Primary Demand Block (IEEE Floating Point)

Primary Minimum Block (IEEE Floating Point)

* Wh received is positive for "view as load", 
delivered is positive for "view as generator"

* resolution of digit before decimal point = 
units, kilo, or mega, per energy format

Primary Energy Block
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Description1 Format Range6
Units or 

Resolution Comments
# 

Reg

Modbus Address

Hex Decimal
0BC1 - 0BC2 3010 - 3011 Volts C-A, Minimum FLOAT 0 to 9999 M volts 2
0BC3 - 0BC4 3012 - 3013 Amps A, Minimum Avg Demand FLOAT 0 to 9999 M amps 2
0BC5 - 0BC6 3014 - 3015 Amps B, Minimum Avg Demand FLOAT 0 to 9999 M amps 2
0BC7 - 0BC8 3016 - 3017 Amps C, Minimum Avg Demand FLOAT 0 to 9999 M amps 2
0BC9 - 0BCA 3018 - 3019 Positive Watts, 3-Ph, Minimum Avg Demand FLOAT 0 to +9999 M watts 2
0BCB - 0BCC 3020 - 3021 Positive VARs, 3-Ph, Minimum Avg Demand FLOAT 0 to +9999 M VARs 2
0BCD - 0BCE 3022 - 3023 Negative Watts, 3-Ph, Minimum Avg Demand FLOAT 0 to +9999 M watts 2
0BCF - 0BD0 3024 - 3025 Negative VARs, 3-Ph, Minimum Avg Demand FLOAT 0 to +9999 M VARs 2
0BD1 - 0BD2 3026 - 3027 VAs, 3-Ph, Minimum Avg Demand FLOAT -9999 M to +9999 M VAs 2
0BD3 - 0BD4 3028 - 3029 Positive Power Factor, 3-Ph, Minimum Avg Demand FLOAT -1.00 to +1.00 none 2
0BD5 - 0BD6 3030 - 3031 Negative Power Factor, 3-Ph, Minimum Avg Demand FLOAT -1.00 to +1.00 none 2
0BD7 - 0BD8 3032 - 3033 Frequency, Minimum FLOAT 0 to 65.00 Hz 2

Block Size: 34

read-only
0C1B  - 0C1C 3100  - 3101 Volts A-N, Maximum FLOAT 0 to 9999 M volts 2
0C1D - 0C1E 3102 - 3103 Volts B-N, Maximum FLOAT 0 to 9999 M volts 2
0C1F - 0C20 3104 - 3105 Volts C-N, Maximum FLOAT 0 to 9999 M volts 2
0C21 - 0C22 3106 - 3107 Volts A-B, Maximum FLOAT 0 to 9999 M volts 2
0C23 - 0C24 3108 - 3109 Volts B-C, Maximum FLOAT 0 to 9999 M volts 2
0C25 - 0C26 3110 - 3111 Volts C-A, Maximum FLOAT 0 to 9999 M volts 2
0C27 - 0C28 3112 - 3113 Amps A, Maximum Avg Demand FLOAT 0 to 9999 M amps 2
0C29 - 0C2A 3114 - 3115 Amps B, Maximum Avg Demand FLOAT 0 to 9999 M amps 2
0C2B - 0C2C 3116 - 3117 Amps C, Maximum Avg Demand FLOAT 0 to 9999 M amps 2
0C2D - 0C2E 3118 - 3119 Positive Watts, 3-Ph, Maximum Avg Demand FLOAT 0 to +9999 M watts 2
0C2F - 0C30 3120 - 3121 Positive VARs, 3-Ph, Maximum Avg Demand FLOAT 0 to +9999 M VARs 2
0C31 - 0C32 3122 - 3123 Negative Watts, 3-Ph, Maximum Avg Demand FLOAT 0 to +9999 M watts 2
0C33 - 0C34 3124 - 3125 Negative VARs, 3-Ph, Maximum Avg Demand FLOAT 0 to +9999 M VARs 2
0C35 - 0C36 3126 - 3127 VAs, 3-Ph, Maximum Avg Demand FLOAT -9999 M to +9999 M VAs 2
0C37 - 0C38 3128 - 3129 Positive Power Factor, 3-Ph, Maximum Avg Demand FLOAT -1.00 to +1.00 none 2
0C39 - 0C3A 3130 - 3131 Negative Power Factor, 3-Ph, Maximum Avg Demand FLOAT -1.00 to +1.00

none
2

0C3B - 0C3C 3132 - 3133 Frequency, Maximum FLOAT 0 to 65.00 Hz 2
Block Size: 34

read-only
0F9F  - 0F9F 4000  - 4000 Reserved UINT16 0 to 9999, or 65535 0.1% 1
0FA0 - 0FA0 4001 - 4001 Reserved UINT16 0 to 9999, or 65535 0.1% 1
0FA1 - 0FA1 4002 - 4002 Reserved UINT16 0 to 9999, or 65535 0.1% 1
0FA2 - 0FA2 4003 - 4003 Reserved UINT16 0 to 9999, or 65535 0.1% 1

Primary Maximum Block (IEEE Floating Point)

Reserved Block7, 13
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Description1 Format Range6
Units or 

Resolution Comments
# 

Reg

Modbus Address

Hex Decimal
0FA3 - 0FA3 4004 - 4004 Reserved 1
0FA4 - 0FA4 4005 - 4005 Reserved 1
0FA5 - 0FA5 4006 - 4006 Reserved 1
0FA6 - 0FA6 4007 - 4007 Reserved 1
0FA7 - 0FA7 4008 - 4008 Reserved 1
0FA8 - 0FA8 4009 - 4009 Reserved 1
0FA9 - 0FA9 4010 - 4010 Reserved 1
0FAA - 0FAA 4011 - 4011 Reserved 1
0FAB - 0FAB 4012 - 4012 Reserved 1
0FAC - 0FAC 4013 - 4013 Reserved 1
0FAD - 0FAD 4014 - 4014 Reserved 1
0FAE - 0FAE 4015 - 4015 Reserved 1
0FAF - 0FAF 4016 - 4016 Reserved 1
0FB0 - 0FB0 4017 - 4017 Reserved 1
0FB1 - 0FB8 4018 - 4025 Reserved 8
0FB9 - 0FBC 4026 - 4029 Reserved 4
0FBD - 0FC4 4030 - 4037 Reserved 8
0FC5 - 0FC8 4038 - 4041 Reserved 4

Block Size: 42

read-only
1003  - 1003 4100  - 4100 Phase A Current SINT16 -1800 to +1800 0.1 degree 1
1004 - 1004 4101 - 4101 Phase B Current SINT16 -1800 to +1800 0.1 degree 1
1005 - 1005 4102 - 4102 Phase C Current SINT16 -1800 to +1800 0.1 degree 1
1006 - 1006 4103 - 4103 Angle, Volts A-B SINT16 -1800 to +1800 0.1 degree 1
1007 - 1007 4104 - 4104 Angle, Volts B-C SINT16 -1800 to +1800 0.1 degree 1
1008 - 1008 4105 - 4105 Angle, Volts C-A SINT16 -1800 to +1800 0.1 degree 1

Block Size: 6

read-only
1387  - 1387 5000  - 5000 Meter Status UINT16 bit-mapped --exnpch ssssssss exnpch = EEPROM block OK flags 

(e=energy, x=max, n=min, p=programmable
settings, c=calibration, h=header), 
ssssssss = state (1=Run, 2=Limp, 10=Prog
Set Update via buttons, 12=Prog Set 
Update via COM2)

1

1388 - 1388 5001 - 5001 Reserved 1
1389 - 138A 5002 - 5003 Time Since Reset UINT32 0 to 4294967294 4 msec wraps around after max coun 2

Block Size: 4

Status Block

Phase Angle Block14
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IQ 100 Series (130/140/150) Meter Appendix B: Modbus Map

Description1 Format Range6
Units or 

Resolution Comments
# 

Reg

Modbus Address

Hex Decimal

write-only
4E1F  - 4E1F 20000  - 20000 Reset Max/Min Blocks UINT16 password5 1
4E20 - 4E20 20001 - 20001 Reset Energy Accumulators UINT16 password5 1

Block Size: 2

read/conditional write
55EF  - 55EF 22000  - 22000 Initiate Programmable Settings Update UINT16 password5 meter enters PS update mode 1
55F0 - 55F0 22001 - 22001 Terminate Programmable Settings Update3 UINT16 any value

meter leaves PS update mode via reset
1

55F1 - 55F1 22002 - 22002 Calculate Programmable Settings Checksum3 UINT16 meter calculates checksum on RAM copy 
of PS block

1

55F2 - 55F2 22003 - 22003 Programmable Settings Checksum3 UINT16 read/write checksum register; PS block
saved in EEPROM on write8

1

55F3 - 55F3 22004 - 22004 Write New Password3 UINT16 0000 to 9999
write-only register; always reads zero

1

59D7  - 59D7 23000  - 23000 Initiate Meter Firmware Reprogramming UINT16 password5 1
Block Size: 6

read/write
61A7  - 61A7 25000  - 25000 Force Meter Restart UINT16 password5

causes a watchdog reset, always reads 0
1

Block Size: 1

read/write
658F  - 659A 26000  - 26011 Perform a Secure Operation UINT16 encrypted command to read password or 

change meter type
12

Block Size: 12

write only in PS update mode
752F  - 752F 30000  - 30000 CT multiplier & denominator UINT16 bit-mapped dddddddd mmmmmmmm high byte is denominator (1 or 5, read-only),

low byte is multiplier (1, 10, or 100)
1

7530 - 7530 30001 - 30001 CT numerator UINT16 1 to 9999 none 1
7531 - 7531 30002 - 30002 PT numerator UINT16 1 to 9999 none 1
7532 - 7532 30003 - 30003 PT denominator UINT16 1 to 9999 none 1

Basic Setups Block

Other Commands Block

Meter Programming Block

Commands Section 4

Programmable Settings Section

Resets Block9

Encryption Block
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IQ 100 Series (130/140/150) Meter Appendix B: Modbus Map

Description1 Format Range6
Units or 

Resolution Comments
# 

Reg

Modbus Address

Hex Decimal
7533 - 7533 30004 - 30004 PT multiplier & hookup UINT16 bit-mapped mmmmmmmm MMMMhhhh MMMMmmmmmmmm is PT multiplier (1, 

10, 100, 1000),
hhhh is hookup enumeration (0 = 3 element 
wye[9S], 1 = delta 2 CTs[5S], 3 = 2.5 
element wye[6S])

1

7534 - 7534 30005 - 30005 Averaging Method UINT16 bit-mapped --iiiiii b----sss iiiiii =  interval (5,15,30,60)
b = 0-block or 1-rolling
sss = # subintervals (1,2,3,4)

1

7535 - 7535 30006 - 30006 Power & Energy Format UINT16 bit-mapped pppp--nn -eee-ddd pppp = power scale (0-unit, 3-kilo, 6-mega, 
8-auto)
nn = number of energy digits (5-8 --> 0-3)
eee = energy scale (0-unit, 3-kilo, 6-mega)
ddd = energy digits after decimal point (0-6)
See note 10.

1

7536 - 7536 30007 - 30007 Operating Mode Screen Enables UINT16 bit-mapped 00000000 eeeeeeee eeeeeeee = op mode screen rows on(1) or 
off(0), rows top to bottom are bits low order 
to high order

1

7537 - 753D 30008 - 30014 Reserved 7
753E - 753E 30015 - 30015 User Settings Flags UINT16 bit-mapped ---g--nn srp--wf- g = enable alternate full scale bargraph 

current (1=on, 0=off)
nn = number of phases for voltage & 
current screens (3=ABC, 2=AB, 1=A, 
0=ABC)
s = scroll (1=on, 0=off)
r = password for reset in use (1=on, 0=off)
p = password for configuration in use 
(1=on, 0=off)
w = pwr dir (0-view as load, 1-view as 
generator)
f = flip power factor sign (1=yes, 0=no)

1

753F - 753F 30016 - 30016 Full Scale Current (for load % bargraph) UINT16 0 to 9999 none If non-zero and user settings bit g is set, 
this value replaces CT numerator in the full 
scale current calculation.

1

7540 - 7547 30017 - 30024 Meter Designation ASCII 16 char none 8
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IQ 100 Series (130/140/150) Meter Appendix B: Modbus Map

Description1 Format Range6
Units or 

Resolution Comments
# 

Reg

Modbus Address

Hex Decimal
7548 - 7548 30025 - 30025 Reserved 1
7549 - 7549 30026 - 30026 COM2 setup UINT16 bit-mapped ----dddd -ppp-bbb 1

754A - 754A 30027 - 30027 COM2 address UINT16 1 to 247 none 1
754B - 754B 30028 - 30028 Reserved 1
754C - 754C 30029 - 30029 Reserved 1
754D - 754D 30030 - 30030 Reserved 1
754E - 754E 30031 - 30031 Reserved 1
754F - 754F 30032 - 30032 Reserved 1
7550 - 7554 30033 - 30037 5
7555 - 7559 30038 - 30042 5
755A - 755E 30043 - 30047 5
755F - 7563 30048 - 30052 5
7564 - 7568 30053 - 30057 5
7569 - 756D 30058 - 30062 5
756E - 7572 30063 - 30067 5

Block Size: 68

read-only except as noted
9C40 - 9C40 40001 - 40001 System Sanity Indicator UINT16 0 or 1 none 0 indicates proper meter operatio 1
9C41 - 9C41 40002 - 40002 Volts A-N UINT16 2047 to 4095 volts 2047= 0, 4095= +150 1
9C42 - 9C42 40003 - 40003 Volts B-N UINT16 2047 to 4095 volts 1
9C43 - 9C43 40004 - 40004 Volts C-N UINT16 2047 to 4095 volts 1
9C44 - 9C44 40005 - 40005 Amps A UINT16 0 to 4095 amps 0= -10, 2047= 0, 4095= +10 1
9C45 - 9C45 40006 - 40006 Amps B UINT16 0 to 4095 amps 1
9C46 - 9C46 40007 - 40007 Amps C UINT16 0 to 4095 amps 1
9C47 - 9C47 40008 - 40008 Watts, 3-Ph total UINT16 0 to 4095 watts 0= -3000, 2047= 0, 4095= +3000 1
9C48 - 9C48 40009 - 40009 VARs, 3-Ph total UINT16 0 to 4095 VARs watts, VARs, VAs = 1
9C49 - 9C49 40010 - 40010 VAs, 3-Ph total UINT16 2047 to 4095 VAs 3000 * (register - 2047) / 2047 1
9C4A - 9C4A 40011 - 40011 Power Factor, 3-Ph total UINT16 1047 to 3047 none 1047= -1, 2047= 0, 3047= +1                      

pf = (register - 2047) / 1000
1

9C4B - 9C4B 40012 - 40012 Frequency UINT16 0 to 2730 Hz 0= 45 or less, 2047= 60, 2730= 65 or more 
freq = 45 + ((register / 4095) * 30)

1

9C4C - 9C4C 40013 - 40013 Volts A-B UINT16 2047 to 4095 volts 2047= 0, 4095= +300 1
9C4D - 9C4D 40014 - 40014 Volts B-C UINT16 2047 to 4095 volts 1
9C4E - 9C4E 40015 - 40015 Volts C-A UINT16 2047 to 4095 volts 1

dddd = reply delay (* 50 msec)
ppp = protocol (1-Modbus RTU, 2-Modbus 
ASCII, 3-DNP)

amps = 10 * (register - 2047) / 2047

12-Bit RTU Readings Section
12-Bit RTU Block

volts = 150 * (register - 2047) / 2047

volts = 300 * (register - 2047) / 2047
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IQ 100 Series (130/140/150) Meter Appendix B: Modbus Map

Description1 Format Range6
Units or 

Resolution Comments
# 

Reg

Modbus Address

Hex Decimal
9C4F - 9C4F 40016 - 40016 CT numerator UINT16 1 to 9999 none 1
9C50 - 9C50 40017 - 40017 CT multiplier UINT16 1, 10, 100 none 1
9C51 - 9C51 40018 - 40018 CT denominator UINT16 1 or 5 none 1
9C52 - 9C52 40019 - 40019 PT numerator UINT16 1 to 9999 none 1
9C53 - 9C53 40020 - 40020 PT multiplier UINT16 1, 10, 100 none 1
9C54 - 9C54 40021 - 40021 PT denominator UINT16 1 to 9999 none 1
9C55 - 9C56 40022 - 40023 W-hours, Positive UINT32 0 to 99999999 Wh per energy format * 5 to 8 digits 2
9C57 - 9C58 40024 - 40025 W-hours, Negative UINT32 0 to 99999999 Wh per energy format

* decimal point implied, per energy format
2

9C59 - 9C5A 40026 - 40027 VAR-hours, Positive UINT32 0 to 99999999 VARh per energy format 2

9C5B - 9C5C 40028 - 40029 VAR-hours, Negative UINT32 0 to 99999999 VARh per energy format 2

9C5D - 9C5E 40030 - 40031 VA-hours UINT32 0 to 99999999 VAh per energy format
* see note 10

2

9C5F - 9C5F 40032 - 40032 Neutral Current UINT16 0 to 4095 amps see Amps A/B/C above 1
9C60 - 9CA2 40033 - 40099 Reserved N/A N/A none 67
9CA3 - 9CA3 40100 - 40100 Reset Energy Accumulators UINT16 password5 write-only register; always reads as 0 1

Block Size: 100

Notes
1
2

3
4

5

* resolution of digit before decimal point = 
units, kilo, or mega, per energy format

ASCII ASCII characters packed 2 per register in high, low order and without any termination characters.  

SINT32 / UINT32
FLOAT

32-bit signed / unsigned integer spanning 2 registers.  The lower-addressed register is the high order half.
SINT16 / UINT16 16-bit signed / unsigned integer.

End of Map

32-bit IEEE floating point number spanning 2 registers.  The lower-addressed register is the high order half (i.e., contains the exponent).

All registers not explicitly listed in the table read as 0.  Writes to these registers will be accepted but won't actually change the register (since it doesn't exist).
Meter Data Section items read as 0 until first readings are available or if the meter is not in operating mode.  Writes to these registers will be accepted but won't actually change the register.

Register valid only in programmable settings update mode.  In other modes these registers read as 0 and return an illegal data address exception if a write is attempted.
Meter command registers always read as 0.  They may be written only when the meter is in a suitable mode.  The registers return an illegal data address exception if a write is attempted in an incorrect 
mode.

If the password is incorrect, a valid response is returned but the command is not executed.  Use 5555 for the password if passwords are disabled in the programmable settings.

Data Formats

CT = numerator * multiplier / denominator

PT = numerator * multiplier / denominator
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IQ 100 Series (130/140/150) Meter Appendix B: Modbus Map

(continued)
6
7
8

9
10
11
12
13
14

15

Not used.
All 3 voltage angles are measured for Wye and Delta hookups.  For 2.5 Element, Vac is measured and Vab & Vbc are calculated.  If a voltage phase is missing,  the two voltage angles in which it 
participates are set to zero.  A and C phase current angles are measured for all hookups.  B phase current angle is measured for Wye and is zero for other hookups.  If a voltage phase is missing, its cu
angle is zero.
If any register in the programmable settings section is set to a value other than the acceptable value then the meter will stay in LIMP mode. Please read the comments section or the range for each register 
in programmable settings section for acceptable  values. 

Not used.

Energy registers should be reset after a format change.
Reset commands make no sense if the meter state is LIMP.  An illegal function exception will be returned.

Not used.
M denotes a 1,000,000 multiplier.

Not used.

Writing this register causes data to be saved permanently in EEPROM.  If there is an error while saving, a slave device failure exception is returned and programmable settings mode automatically 
terminates via reset.
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